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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.
Copying or printing the following items is generally prohibited by local law:
bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® s a registered trademark of Hewlett-Packard Company.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and True Type are trademarks of Apple Computer,
Inc., registered in the U.S. and other countries.

Bonjour™ is a trademark of Apple Computer, Inc., registered in the U.S. and other countries.
IPS-PRINT™ Printer Language Emulation Copyright® 2000, Oak Technology, Inc., All Rights Reserved.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

NetWare is a registered trademark of Novell, Inc.

PictBridge is a trademark.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows® 95

* The product name of Windows® 98 is Microsoft® Windows® 98

* The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me)

* The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

» The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional

» The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition

* The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Notes

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

Depending on which country you are in, certain units may be optional. For details, please contact your
local dealer.



Manuails for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

% About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

% General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

« Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, staples, and other consumables.

R
°o

Security Reference

This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use.

Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

R
o

Copy/Document Server Reference
Explains Copier and Document Server functions and operations. Also refer to
this manual for explanations on how to place originals.

< Facsimile Reference
Explains Facsimile functions and operations.

< Printer Reference
Explains Printer functions and operations.

% Scanner Reference
Explains Scanner functions and operations.

% Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.



< Other manuals

* Manuals for This Machine

* Safety Information

* Quick Reference Copy Guide

e Quick Reference Fax Guide

¢ Quick Reference Printer Guide

¢ Quick Reference Scanner Guide

¢ PostScript3 Supplement

¢ UNIX Supplement

* Manuals for DeskTopBinder Lite
* DeskTopBinder Lite Setup Guide
¢ DeskTopBinder Introduction Guide
¢ Auto Document Link Guide

& Note
O Manuals provided are specific to machine types.

O Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

O For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

O “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

/\ WARNING:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the "Safety Information" section of About This Ma-
chine.

/\ CAUTION:

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the

machine or to property. Be sure to read these notes. They can be found in the
"Safety Information" section of About This Machine.

*gklmportant

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

& Note

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

A Reference

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[]

Indicates the names of keys that appear on the machine’s display panel.

[]

Indicates the names of keys on the machine’s control panel.



Display Panel

This section describes configuration using the display panel when the printer

function is selected.

Initial Display

ﬂlmportant

O The machine switches to offline when you make settings when the machine
is online. After you complete the setting, the machine switches to online au-

tomatically.

O If you make a setting when the machine is offline, it will stay offline after-

wards.

O The function items displayed serve as selector keys. You can select or specify

an item by pressing it lightly.

O When you select or specify an item on the display panel, it becomes highlighted.

O Keys dimmed (for example,

) cannot be used.

3 T > Job Lists & Error Log
4 — bReset | | o Printdbs |, Erorle J_y_Seoolim soblist__|
5 6

1. Operational status or messages
Displays current machine status, such as
“Ready”, “Offline”, and “Printing...”. In-
formation about the print job (user ID
and document name) appears in this sec-
tion.

2. [ Online] / [k+Offline]

When you press these keys, the machine
switches between online and offline.
When the machine is online, it can re-
ceive data from the computer.

When the machine is offline, it cannot re-
ceive data from the computer.

AMU002S

3. [Form Feed]

Press to print all the data left in the ma-

chine's input buffer.

¢ When the machine is online, the status
appears dimly.

¢ This function is not available with the
RPCS printer language.

4. [Job Reset]

Press to cancel the current print job.

If you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.



5. [Print Jobs]

Press to display print jobs sent from a

computer.

6. [Error Log]

Press to display the error logs of print

jobs sent from a computer.

& Note

7. [Spooling Job List]
Press to display spooled jobs.

8. Paper Tray Status indicators
The paper tray settings appear.

O When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “System Settings”, General

Settings Guide.

Simplified Display

This section explains how to switch to the simplified display.

When you press [ Simplified Display ], the screen changes from the initial display
to the simplified display. Letters and keys are displayed at a larger size, making

operations easier.

(IO

 Example of a simplified display

ANP042S

Ready

B Online
§ » Paper Tray Status

|
worive | [

Job Reset

& Note

O To return to the initial display, press [ Simplified Display ] again.
O Certain keys do not appear on the simplified display.



Job List

Jobs printed using Copy, Document Server or Printer mode are temporarily
stored in the machine, and then executed in order. Using the Job List function
allows you to manage these jobs. For example, you can cancel incorrect job set-
tings or print an urgent document.

& Note
O You cannot use the Job List function when Interrupt Copy is active.

O Documents that were printed using the Facsimile function are not displayed
in the job list.

Job List screen

This section explains displays and icons that appear in the Job List screen.

The Job List screen varies depending on whether [Job Order] is selected with
Print Priority for the System Settings. For the setting procedure, see "Print Prior-
ity", General Settings Guide.

< When [Job Order] is not selected:
The job list is displayed for each of the functions.

1

|

2

Exit
Curtent / Waiting Job List [ Job History =

Copier / Document Server Printer Others

Status. No. User Name File Name Original Quantity Time Reouired  Waiting Jobs: 1
Printing 0104 1/ 8 | 1mn

/Add paer to Tray 1.

001 Scaming |3 105 7 J

Ilpad 8 1/2 % 1139 size paper.

AMGO037S



% When [Job Order] is selected:
The job list is displayed for all functions in the order of print jobs.

B JobList |
| Curent / Waiting kb List | Job History

Status. No. User Name File Name. Original Quantity Time Reuired  Waiting Jobs: 1
Printing ER 2] 5 | 1mn

Add paper to Tray 1.

001 0108 1/ 10 1mn

AMGO038S

@ Switches between job lists for each function.

@ Switches between [Current / Waiting Job List] and [Job History].
® Reserved job numbers are displayed.

@ Functions that printed jobs are displayed.
[d: Job printed using copy function.
8: Job printed using printer function.
[} Job printed using Document Server function.
&: Job printed using DeskTopBinder.
&: Job printed using Web Image Monitor.

Checking jobs in the print queue

You can check the contents of jobs in the print queue.

ﬂ Press [Job List].

ﬂ Select the job you want to check.

B Job List
J Current / Waiting Job List [ Job History
Status N User Name File Name Original Quantity Time Recuired Waiting Jobs: 1

Prints|2.107 21 5 | 1mn]

0 | 1mn)

B Press [Details], and then check the contents.
ﬂ Press [Exit].



Changing the order of jobs

You can change the order in which print jobs in the job list are served:

K Press [Job List].

ﬂ The job whose order you want to change.

B Job List
| Current / Waiting Job List [ b History

Status. No. User Name File Name Original Quantity Time Recuired Waiting Jobs: 3
Printis (2109 120 1mn Details

Add paper to Tray 1. Change Order
001 [EED 140 | 2min) | SusoendPrinting
[ om 21 B Delete Reservation
003 o 1m2 3] 5 | 1mn

Systen Status

B Press [Change Order].

ﬂ Change the order using [Top], [Previous], or [Next].

B Job List
| Curent / Waitig b st \[ Job History

Status. No. User Name File Name Original Quantity Tire Reswired Waiting Jobs: 3
pintiba |3 109 12 | Tmin [chene Orcer

Add paver to Tray 1. Lo
001 (@ 10 1/ 80 2mn) | (A To

002 om 205
003 ER 3] 5 | 1mn

System Status || JobLi

B Press [OK].

Holding print jobs

The machine holds a job currently printing or jobs in the print queue:
B press [Job List].
B select the job(s) to hold.

B Job List
| Curent / Waitig kb List\[ Job History

Status. No. User Name File Name Original Quantity Time Reouired  Waiting Jobs: 3
printha |3 109 12 | 1mi) Details

Add paper to Tray 1. Change Order
o0 o0 1w Suspend Prining
002 Bm 2| 15 | min] [ Delete Reservation
003 (@ 1m 3] 5 | 1mn

Ssten Status || dobList_|

B Press [Suspend Printing].



Deleting jobs

You can delete a job currently printing or jobs in the print queue:
K Press [Job List].
ﬂ Select the job to be deleted.

B Job List
| Current / Waiting Job List [ b History

Status. No. User Name File Name Original Quantity Time Recuired 'Waiting Jobs: 3
Prints (2 109 1/ 20 | 1min Details

Add paper to Tray 1. Change Order
o0 @10 1@ Susoend Printing
002 @m 2 15 | 1min| [ Delete Reservation
003 @12 30 5 | 1mn

To delete multiple print jobs, select all print jobs you want to delete.
B Press [Delete Reservation].

ﬂ Press [Yes].



Printer Features Menu

The following explains settings and meanings of functions the Printer Features
screen. Select [Printer Feature] after you press the [ User Tools/Counter ] key. For de-
tails, see “Printer Features”, General Settings Guide.

« List/ Test Print

Menu

Description

Multiple Lists

You can print the configuration page and er-
ror log.

Configuration Page

You can print the machine's current configu-
ration values.

Error Log You can print error logs listing all errors that
occurred during printing.
Menu List You can print a Menu List showing the ma-

chine's function menus.

PCL Configuration / Font Page

You can print the current configuration and
installed PCL font list.

PS Configuration / Font Page

You can print the current configuration and
installed PostScript font list.

This menu can be selected only when the op-
tional PostScript 3 unit is installed.

PDF Configuration / Font Page

You can print the current configuration and
installed PDF font list.

This menu can be selected only when the op-
tional PostScript 3 unit is installed.

Hex Dump

You can print in the Hex Dump mode.

< Maintenance

Menu

Description

Menu Protect

This function lets you protect menu settings
from accidental change. It makes it impossi-
ble to change menu settings with normal
procedures unless you perform the required
key operations.

In a network environment, only administra-
tors can make changes to menu settings.

List / Test Print Lock

You can lock the [List/ Test Print] menu.

Delete All Temporary Print Jobs

You can delete all print jobs temporarily
stored in the machine.

Delete All Stored Print Jobs

You can delete all print jobs stored in the ma-
chine.

4 Colour Graphic Mode

You can adjust the image density.




% System

Menu

Description

Print Error Report

You can print an error report when a printer
Or memory error occurs.

Auto Continue

You can select this to enable Auto Continue.
When it is On, printing continues after a sys-
tem error occurs.

Memory Overflow

Select this to have a memory overflow error
report printed.

Job Separation

You can enable Job Separation.

This menu can be selected only when a fin-
isher (optional) is installed.

Auto Delete Temporary Print Jobs

You can select to automatically delete print
jobs temporarily stored in the machine.

Auto Delete Stored Print Jobs

You can select to automatically delete print
jobs stored in the machine.

Initial Print Job List

You can set the default Printer screen when
you press [Print Jobs].

Memory Usage

You can select the amount of memory used
in Font Priority or Frame Priority, according
to paper size or resolution.

Duplex

You can select to have print on both sides of
each page.

Copies

You can specify the number of print sets.
This setting is disabled if the number of pag-
es to print has been specified with the printer
driver or another command.

Blank Page Print

You can select whether or not to print blank
pages.

Reserved Job Waiting Time

You can specify how long the machine waits
to receive a print job before allowing other
functions such as the copier and scanner
functions to interrupt it.

Printer Language

You can specify the printer language.

Sub Paper Size You can enable the Auto Substitute Paper
Size (A4 LT) feature.

Page Size You can select the default paper size.

Letterhead Setting You can rotate original images when printing.

When printing, original images are always
rotated by 180 degrees. Therefore, output
might not be as expected when printing onto
letterhead or preprinted paper requiring ori-
entation. Using this function, you can specify
image rotation.




Menu Description

Bypass Tray Setting Priority You can specify which of the two options,
(Printer) Driver / Command or Machine Set-
tings, has priority for determining the paper
size for the bypass tray.

Edge to Edge Print You can select whether or not to print on the
entire sheet.

Default Printer Language You can set the default printer language if
the machine cannot find the printer language
automatically.

Tray Switching You can set to switch the paper tray.

+ Host Interface

Menu Description
I/0 Buffer You can set the size of the I/O Buffer. Nor-
mally it is not necessary to change this set-
ting.
I/0 Timeout You can set how many seconds the machine

should wait before ending a print job. If data
from another port usually arrives in the mid-
dle of a print job, you should increase this

timeout period.
% PCL Menu
Menu Description

Orientation You can set the page orientation.

Form Lines You can set the number of lines per page.

Font Source You can set the storage location of the de-
fault font.

Font Number You can set the ID of the default font you
want to use.

Point Size You can set the point size you want to use for
the selected font.

Font Pitch You can set the number of characters per
inch for the selected font.

Symbol Set You can specify the set of print characters for
the selected font. The available options are as
follows:

Courier Font You can select a courier font type.

Extend A4 Width You can extend the printing area width
when printing on A4 sheet with PCL.

Append CR to LF When set to On, a carriage return will follow
each line feed: CR=CR, LF=CR-LF, FF=CR~
FF.

Resolution You can set the print resolution in dots per

inch.




% PS Menu (optional)

Menu Description
Data Format You can select a data format.
Resolution You can set the print resolution in dots per
inch.
Colour Setting You can make an RGB setting.
Colour Profile You can set the colour profile.

% PDF Menu (optional)

Menu Description

Change PDF Password You can set the password for the PDF file ex-
ecuting PDF Direct Print.

PDF Group Password You can set the group password already
specified with DeskTopBinder Lite.

Resolution You can set the print resolution in dots per
inch.

Colour Setting You can make an RGB setting.

Colour Profile You can set the colour profile.

& Note

O Some options do not appear depending optional units or selected printer lan-
guages.

O Some options cannot be set depending on security settings.

/O Reference
For details, see “Printer Features”, General Settings Guide.

For more information about copier features and system settings, see Copy
Reference and General Settings Guide.

11



12

Setting Paper on the Bypass Tray

This section gives instructions for setting paper on the bypass tray.

For details about paper size and paper type, see “Paper Size and Paper Type”,
About This Machine.

ﬂlmportant
O The following functions are disabled when printing from the bypass tray:

¢ Duplex/Booklet printing

Auto Tray Select

Auto Tray Switching

Rotating Collate

Staple (when the optional unit is installed)
¢ Punch (when the optional unit is installed)

ﬂ Open the bypass tray.

AMF023S



ﬂ Gently insert paper face down into the bypass tray until the beeper sounds,
and then adjust the paper guides to the paper size.

If the paper size of the paper guide and the paper do not match, skewing and
misfeeds might occur.

Do not stack paper over the limit mark, otherwise a skewed image or mis-
feeds might occur.

Open out the extender to support paper sizes larger than A4 7, 8!/, x11 [5.
Fan the paper to get air between the sheets to avoid a multi-sheet feed.

=
N
\

o

{\1

AMF024S

1. Extender
2. Paper Guide

8 Set the paper size using the printer driver or the control panel.

The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features]. In that case,
set the paper size using the printer driver.

& Note

O Paper sizes that can be loaded onto the bypass tray are 90 - 305 mm (3.6 -
12 in.) vertical, and 148 - 600 mm (5.9 - 23.7 in.) horizontal.

O When loading OHP transparencies or thick paper, set paper size and paper
type.

O The number of sheets that can be loaded in the bypass tray depends on the
paper type.

/O Reference

When loading letterhead paper, pay attention to its orientation. See Gener-
al Settings Guide.

For printer driver settings, see the printer driver Help.
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Setting the Paper Size Using the Control Panel

Follow the procedure below to set the machine using the control panel when
loading standard size paper onto the bypass tray.

iﬁklmportant

O The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer
Features”, General Settings Guide). In that case, set the paper size using the
printer driver.

O Under [Printer Features], [System], if you set [Bypass Tray Setting Priority] to [Driv-
er / Command] , paper size settings made on the printer driver must match
those made on the control panel. If they do not match, an error message ap-
pears and printing stops if [Printer Features], [System], [Auto Continue] is not set.
For details about [Printer Features] settings, see General Settings Guide.

0 press the [User Tools/Counter] key on the control panel.
EI Press [System Settings].

B Press the [Tray Paper Settings] tab.

ﬂ Press [Printer Bypass Paper Size].

[ T T e oo T

Tray Paper Size: Tray 2

Tray Paper Size: Tray 3

Tray Paper Size: Tray 4

Printer Bypass Paper Size

1 A Proving ||W hewt

B Select the paper size.
B Press [OK].

ﬂ Press the [User Tools/Counter] key.
The initial screen appears.

& Note

O When loading OHP transparencies or thick paper, set paper size and paper
type.

O [Auto Detect] is the default setting for [Printer Bypass Paper Size].

A Reference
For printer driver settings, see the printer driver Help.



Setting Custom Size Paper Using the Control Panel

Follow the procedure below to set the machine using the control panel when
loading custom size paper onto the bypass tray.

iﬁklmportant
O The following procedures are not required if you select [Driver / Command] from

[Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer Features”,
General Settings Guide). In that case, set the paper size using the printer driver.

O If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “Printer Features”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray Set-
ting Priority] in [System] of [Printer Features] (see “Printer Features”, General Set-
tings Guide). Set paper size using the control panel.

0 press the [User Tools/Counter] key on the control panel.
B Press [System Settings].

B Press the [Tray Paper Settings] tab.

ﬂ Press [Printer Bypass Paper Size].

B Press [Custom Size].

Custom Size

Select vertical or horizontal key.

1 Vertical
=

- mm
< 90.0~305.0-

<148.0~600.0>

If a custom size is already set, press [Change Size].

B Press [Vertical], enter the vertical size of the paper using the number keys,
and then press the [ ] key.

ﬂ Press [Horizontal], enter the horizontal size of the paper using the number
keys, and then press the [ ] key.

B Press [OK].
The paper sizes entered are displayed.

ﬂ Press the [ User Tools/Counter] key.
The initial screen appears.
& Note
O When loading OHP transparencies or thick paper, set paper size and paper type.
O For printer driver settings, see the printer driver Help.

15
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Setting Thick Paper or OHP Transparencies Using the Control
Panel

Follow the procedure below to set the machine using the control panel when
loading thick paper or OHP transparencies onto the bypass tray.

iﬁklmportant

O The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “Printer
Features”, General Settings Guide). In that case, set the paper size using the
printer driver.

O If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “Printer Features”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray Set-
ting Priority] in [System] of [Printer Features] (see “Printer Features”, General Set-
tings Guide). Set the paper size using the control panel.

0 press the [User Tools/Counter] key on the control panel.
8 Press [System Settings].

B Press the [Tray Paper Settings] tab.

ﬂ Press [V Next] to scroll through the list.

B Press [Paper Type: Bypass Tray].

B Press [OHP (Transparency)] on the [Paper Type] area when loading OHP trans-
parencies. Press [No Display] on the [Paper Type] area, and then press [Thick Pa-
per 1], [Thick Paper 2], or [Thick Paper 3] on the [Paper Thickness] area when
loading thick paper.

Pacer Type: Bypass Tray Cancel 3
Select item, then ress [0K]
»Paoer Type »Paver Thikness
No Disolay Recycled Paper | | Colour Paver | Thin Paper |
Letterhead Label Paver O (e ) Plain Paver
Special Paver 1_| [__Special aper 2_| [ Special Paver 3_| Midde Thick |
Cardstock Presrinted Paper || BondPaver | Thick Paver 1|
Thick Paper 2
Thick Paper 3

Paper Type: Bypass Tray Cancel OK

Select item, then press [OK].

P-Paver Type P-Paver Thickness
NoDisplay Recycled Paver | [_Colour Paver_| Thin Paper |
Letterhead Lobel Pooer | [ OHp (rnsrey) )| PlainPoer |

Special Paver 1_| | _Special Paver 2_| [ Special Paper 3_| Middle Thick |
Cardstock Preornted Paper | | BondPaper | Thick Paper 1
Bk Copid oer Thick Paver 2
Thick Paver 3




H press [ok).
The paper type selected is displayed.

8 Press the [ User Tools/Counter] key.
The initial screen appears.

4 Note

O The settings made will remain valid until they are reset again. After print-
ing on OHP transparencies or thick paper, make sure to clear settings for
the next user.

O For printer driver settings, see the printer driver Help.
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1. Preparing the Machine

Confirming the Connection Method

This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using This Machine as the Windows Printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IPv4 over 1394).

Available ports are determined based on the combination of Windows operating
system version and connection method used.

SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client
-TCP/IP -TCP/IP -TCP/IP -TCP/IP
-IPP -IPP -IPP -IPP
- <, Standard TCP/IP <., Standard TCP/IP <, LPR
I LPR I LPR I
Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

27220358

< Windows 95/ 98

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port

IEEE 1394 (IPv4 over 1394)

None
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R
°%

Windows Me

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port

Windows 2000

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP

LPR port
IEEE 1394 (IPv4 over 1394) None
< Windows XP
Connection Method Available Ports

2
*»*

2
*»*

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

Windows Server 2003

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

Windows NT 4.0

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
LPR port

IEEE 1394 (IPv4 over 1394)

None

,O Reference

See the explanation about how to install the printer driver for each type of
port. For the SmartDeviceMonitor for Client port, see p.24 “Using the Smart-
DeviceMonitor for Client Port”.

For the Standard TCP/IP port, see p.30 “Using the Standard TCP/IP Port”.
For the LPR port, see p.32 “Using the LPR Port”.



Confirming the Connection Method

Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0 NetWare NetWare
Print Server Print Server File Server
N§y
S

Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

272036S

& Note
O In an IPv6 environment, Netware servers cannot be used.

A Reference
See the explanation about how to install the printer driver for each type of
network printer.
For the Windows network printer, see p.34 “Using as a Windows Network
Printer”.

For the NetWare print server and remote printer, see p.36 “Using as a Net-
Ware Print Server / Remote Printer”.
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Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.

Windows operating system version determines the available connection methods.

Windows 95:
Parallel connections

Windows 98:
Parallel connections

Windows 98 SE / Me:
USB and Parallel connections

Windows 2000:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows XP:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows Server 2003:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows NT 4.0:
Parallel connections

p Reference

See the explanation about how to install the printer driver for each method of
connection.

For the USB connection, see p.39 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.44 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.46 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.51 “Printing with Bluetooth Connection”.



Installing the Printer Driver

Installing the Printer Driver

This section explains how to install the printer driver. There are two ways to in-
stall the printer driver: using Quick Install, which installs the settings at once, or
installing the appropriate driver according to the port you want to use.

Quick Install

Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, and Windows NT 4.0
users can easily install this software using the supplied CD-ROM.

Using Quick Install, the PCL printer driver and/or RPCS printer driver, Desk-
TopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.

ﬂlmportant

O To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

O If you connect using USB, refer to p.39 “Installing the Printer Driver Using
USB” and install the printer driver.
ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
8 Select an interface language, and then click [OK].
The default interface language is English.

O click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.
B After reading the agreement, click [l accept the agreement.], and then click
[Next >].

E Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].

For parallel connection, select the machine whose printer port is displayed in
[Connect To].

U crick pinstall).
The printer driver installation starts.

23
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B click [Finish.

A message about restarting the computer appears. Restart the computer to
complete installation.

g Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

/O Reference
Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.56 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.

Installing the Printer Driver for the Selected Port

Using the SmartDeviceMonitor for Client Port

ﬂlmportant

O To install SmartDeviceMonitor for Client under Windows 2000 / XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

O Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client].



Installing the Printer Driver

B Select an interface language, and then click [Next >].
The default interface language is English.

B The message to quit all other applications appears. Quit all applications,
and then click [Next >].

ﬂ The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

B Click [Full install] or [Custom Install].

[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.

[Custom Install] installs selected applications.

g Follow the instructions on the display and click [Next >] to proceed to the
step.

[[D After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].
Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

ﬂ Open the [Printers] window from the [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
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Preparing the Machine

Windows 2000 / Windows NT 4.0:

ﬂ Open [Printers] window from the [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E] On the [Ports] tab, click [Configure Port].
The [Configuration] dialog box appears.

Windows XP, Windows Server 2003:

ﬂ Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

B Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.

& Note
O For TCP/IP, timeout setting can be configured.

O User, proxy, and timeout settings can be configured for IPP.

O If no settings on the [Recovery/Parallel Printing] tab are available, follow the
procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

® Start SmartDeviceMonitor for Client, and then right-click the SmartDe-
viceMonitor for Client icon on the tasktray.

® Point to [Properties], and then click [Extended Features Settings].
@ Select the [Set Recovery/Parallel Printing for each port] check box.
® Click [OK] to close the [Extended Features Settings] dialog box.

/O Reference

For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.

Installing the PCL or RPCS Printer Driver (TCP/IP)

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.



Installing the Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O Click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [| accept the agreement.], and then click [Next >].

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U Click [Next >].

8 Select the machine model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ﬁ] Click [Port:], and then click [Add].
m Click [SmartDeviceMonitor], and then click [OK].

(B Click [TCPAP], and then click [Search].
A list of printers using TCP/IP appears.

[B Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

ﬂ] Check that the port of the selected printer is displayed in [Port:].

iE Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

[E Select the [Default Printer] check box to configure the printer as default.
W click [Continue].

Installation starts.
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[E] After the installation is completed, select one of the options to restart the

computer either now or later, and then click [Finish].
Restart the computer to complete installation.

@ Note

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check statistics about the number of sheets which each user
prints. For details, see SmartDeviceMonitor for Admin Help.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Under Windows 95 / 98 / Me, you cannot add an IP address partially sim-
ilar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used.

p Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Installing the PCL or RPCS Printer Driver (IPP)

ﬂlmportant
O To install printer driver under Windows 2000 / XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

O Click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

ﬂ Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.



Installing the Printer Driver

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

8 Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

B Click [Port:], and then click [Add].

[[D Click [SmartDeviceMonitor], and then click [OK].
B click peey.
[ﬂ In the [Printer URL] box, enter “http://printer's address/printer” as the print-

er's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https:/ /printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter “http:/ /printer's address/ipp” as the printer's address.

[B Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

ﬂ] Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B cick oK.
[E Check that the port of the selected printer is displayed in [Port:].

[ﬂ Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

iE Select the [Default Printer] check box to configure the printer as default.

[E] Click [Continue].
Installation starts.

Eﬁ] After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.
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& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check the number of sheets each user prints. For details, see
SmartDeviceMonitor for Admin Help.

p Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Using the Standard TCP/IP Port

This describes how to install the PCL or RPCS printer driver using the TCP/IP
port.

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, and
Windows Server 2003, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

O In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor for Client port.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.



Installing the Printer Driver

U crici [Next >].

8 Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

@ Click [Port:], and then click [Add].

ﬂ] Click [Standard TCP/IP Port], and then click [OK].
Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

[B Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

[ Click [Next >].

iE Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

[E Check that the port of the selected printer is displayed in [Port:].
[ﬂ Configure the default printer as necessary.

B click [Continue].
The printer driver installation starts.

[ﬂ After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
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A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Using the LPR Port

This describes how to install the PCL or RPCS printer driver using the LPR port.

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name'] box.

B crici Next >].

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[m Click [Port:], and then click [Add].



Installing the Printer Driver

ﬂ] Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

m Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[B Enter “1p” in the [Name of printer or print queue on that server] box, and then click
[OK].

The port is added.
ﬂ] Check that the port of the selected printer is displayed in [Port:].
iE Configure the default printer as necessary.

[ ctick [Continue].
The printer driver installation starts.

[ﬂ After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

p Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a Windows Network Printer

This describes how to install the PCL or RPCS printer driver when using the
printer as a Windows network printer.

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000 / XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communicate
with a Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0 print
server. Do not begin the following procedure before the client is set up and con-
figured correctly.

iﬁklmportant

O To install the printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

O If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client.

O If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

E] Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U Click [Next >].



Using as a Windows Network Printer

B Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

m Click [Port:], and then click [Add].
[ Click [Network Printer], and then click [OK].

m Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

[B Select the printer you want to use, and then click [OK].
ﬂ] Check that the port of the selected printer is displayed in [Port:].

iE Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

[E Select the [Default Printer] check box to configure the printer as default.

W click [Continue].
The printer driver installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

4 Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

p Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a NetWare Print Server / Remote
Printer

This describes how to set up the Windows computer used as the NetWare client.

iﬁklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O In an IPv6 environment, Netware servers cannot be used.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:

¢ Operating system: Windows 98

¢ NetWare version: 4.1

¢ File server name: CAREE

¢ Queue name: R-QUEUE

) insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

ﬂ Select an interface language, and then click [OK].
The default interface language is English.

B Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

[ crici Next >1.

ﬂ Select the [Printer Name] check box to select the printer model you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.



Using as a NetWare Print Server / Remote Printer

8 Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

g Click [Port:], and then click [Add].

[ Click [Network Printer], and then click [OK].

ﬂ] Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.
[E] Select the print queue, and then click [OK].
[B Check that the port of the selected printer is displayed in [Port:].

0 click [Continue].
The printer driver installation starts.

B click [Finish] in the [Select Program] dialog box.

m After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

[ﬂ After restarting the computer, launch the [Printers] window, and then open
the printer properties.

Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

[B On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correct-

ly.
[ﬂ Click [OK] to close the printer properties dialog box.

4 Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O The protocol is set to inactive as default. Enable it using SmartDeviceMon-
itor or Telnet.
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Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-

er driver on Windows. If NetWare form feed is configured, the printer may not

print properly.

Follow the procedure below to disable form feed according to the operating sys-

tem used:

e Under Windows 95 / 98 / Me, clear the [Form feed] check box on the [Printer
Settings] tab in the printer properties dialog box.

e Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating
system used:

e Under Windows 95 / 98 / Me, clear the [Enable banner] check box on the [Print-
er Settings] tab in the printer properties dialog box.

e Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows Me - USB

ﬂlmportant
O Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-
dows Me or later.

O Download USB Printing Support for Windows Me from the seupplier's Web
site.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

ﬂ Download USB Printing Support from the supplier's Web site.

Use a search to find the model name, and then download USB Printing Sup-
port from the supplier's Web site.

Save it where you can locate it easily.

g Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

ﬂ Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

ﬂ Specify the location where USB Printing Support is located, and then click
[Next >].

B Check the location, and then click [Next >].
USB Printing Support is installed.

 click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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B Insert the printer driver. Click [Search for the best driver for your device. [Recom-
mended]], and then click [Next >].

g Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

m Insert the CD-ROM into the CD-ROM drive.

& Note
3 When Auto Run starts, click [Exit].

O To disable Auto Run, press the [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

ﬂ] Specify the location where the source files of the printer driver are stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN9X_ME\ (Language)\DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN9X_ME\ (Language) \DISK1

e PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN9X_ME\ (Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN9X_ME\ (Language)\DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN9X_ME\ (Language)\DISK1
[E] Check the location, and then click [Next >].
Add Printer Wizard starts.

B click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.

O Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

O After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.
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Windows 2000 - USB

ﬂlmportant

O Installing a printer driver requires Administrator permission. Log on using
an account that has Administrator permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

ﬂ In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

8 Select the [Specify location] check box, and then click [Next >].

ﬂ Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

B Specify the location where the source files of the printer driver are stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

e PCL 5e (for B & W printing)
D:ADRIVERS\PCL5E\WIN2K_XP\(Language)\ DISK1

e PCL6
D:\ADRIVERS\PCL6\WIN2K_XP\(Language) \DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

B Check the printer driver location, and then click [OK].
U crick [Next >].
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B click [Finish.

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

ﬁ*lmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B 1n the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

E) insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.



Installing the Printer Driver Using USB

ﬂ Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in

the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

e PCL 5c (for colour printing)
D:\ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

¢ PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

B Check the printer driver location, and then click [Next >].
(3 ciick [continue].
U click [Finish].

If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.
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Printing with Parallel Connection

This describes how to install the PCL or RPCS printer driver when using the par-
allel port.

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

ﬁklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U crick [Next >].

8 Select the [Printer Name] check box to select the printer model you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[m Check that [LPT1:] is shown in [Port:].
ﬂ] Select the [Default Printer] check box to configure the printer as default.

B Click [Finish].
The printer driver installation starts.



Printing with Parallel Connection

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

@ Note u

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

ﬂlmportant
O Quit all applications currently running, and do not print during installation.

O Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

O Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

O SCSI print must be set to “active” from the control panel. For details, see Net-
work Guide.

@ Note

O This machine can receive print data from one computer at a time only. A mes-
sage may appear if print jobs from different computers collide.

O If jobs collide, the first received job is printed first.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

This describes how to install the printer driver to the computer with Windows
2000 installed, using IEEE 1394 (SCSI print).

ﬁ*lmportant

O If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the “1394_00n" port, click [1394_00] as a port during the printer
driver installation.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O The optional 1394 interface unit can be used only with Service Pack 1 (S5P1) or
higher.

ﬂ Connect the machine to the computer using the IEEE 1394 interface cable.
B Clici [Next >] in the [Found New Hardware Wizard] dialog box.

B When the message “This wizard will complete the installation for this De-
vice: Unknown” appears, click [Specify a location], and then click [Next >].

ﬂ When the message “Locate Driver Files” appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].



Installing the Printer Driver Using IEEE 1394 (SCSI print)

B 1nsert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

(3 click [Browse].

ﬂ Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language) \DISK1

PCL 5c¢ (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\ (Language) \DISK1

PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

PCL 6
D:\DRIVERS\PCL6\WIN2K_XP\(Language) \DISK1

PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

8 Click [Open].
B crick [ok).

[[U Follow the on-screen instructions.

When installation is complete, the printer connected to “1394_00n" appears
in the [Printers] window: (“n” shows the number of printers connected.)

If the printer driver has already been installed, the printer icon is added to the
[Printers] window. In this case, printer driver installation is not necessary.

If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see Trouble Shooting
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& Note

O If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.

® When the [Found New Hardware Wizard] dialog box appears, click [Next >].

® When the message “This wizard will complete the installation for this
Device: Unknown” appears, select the [Search for a suitable driver for my
device [recommended]] check box, and then click [Next >].

® When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

@ When the message “Driver Files Search Results” appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish].

Windows XP, Windows Server 2003

This describes how to install the printer driver to the computer with Windows
XP or Windows Server 2003 installed, using IEEE 1394 (SCSI print).

ﬂlmportant
O SCSI print must be set to “active” from the control panel. For details, see Net-
work Guide.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Connect the machine to the computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

ﬂ Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

B When the message “Please choose your search and installation option.” ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

ﬂ Insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM into the
drive and keep it pressed until the computer finishes reading from the CD-ROM.



Installing the Printer Driver Using IEEE 1394 (SCSI print)

B Specify the location where the source files of the printer driver are stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in

the following location:

e RPCS
D:ADRIVERS\RPCS\WIN2K_XP\(Language) \DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

¢ PCL 5e (for B & W printing)
D:ADRIVERS\PCL5E\WIN2K_XP\(Language)\ DISK1

e PCL6
D:ADRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

¢ PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:ADRIVERS\PS\WIN2K_XP\ (Language) \DISK1

When installation is complete, the printer connected to “1394_00n" appears in
the [Printers and Faxes] window. (“n” shows the number of printers connected.)

E Follow the on-screen instructions.

If the printer driver has already been installed, the printer icon is added to the
[Printers and Faxes] window. In this case, printer driver installation is not nec-
essary.

Even if the printer driver is already installed, the message “Found New Hard-
ware Wizard” may appear when the machine is connected to the computer
using the IEEE 1394 interface cable for the first time. In that case, install the
printer driver.

4 Note

O This machine can receive print data from one computer at a time only. If a
print job from a computer collides with other data, a message may appear
on the computer.

O To install another printer driver after setting the “1394_00n” port, click
[1394_00] as a port during the printer driver installation.

O When the printer driver is properly installed, connecting or disconnecting
the optional IEEE 1394 cable causes the printer icon to change.

O If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see Trouble Shooting.
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O If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below:

® When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] is displayed, select the
[Install from a list on specific location (Advanced)] check box, and then click
[Next >].

® When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

® When the message “The wizard could not find the software on your
computer for..” appears, click [OK].

@ When the message “Cannot Install this Hardware” appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

This describes how to print with Bluetooth devices.

Supported Profiles

Refer to following supported profiles for Bluetooth connection.

% SPP, HCRP

* A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

* When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

* SPP connection does not support bidirectional communications.
¢ HCRP connection supports bidirectional communications.

< BIP
¢ For BIP connection, a module including PostScript 3 must be installed in
the machine.

* Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

* Only JPEG images can be printed using BIP.

* User codes are disabled for BIP.
You cannot print if print functions are restricted.

* Some printers do not support BIP.

@ Note

O Instructions in this manual relate to printing via SPP. To print using HCRP or
BIP, see the Help supplied with the Bluetooth adapter you use.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel inter-
face.

ﬂlmportant

O To install the printer driver under Windows 2000 / XP Professional or Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

ﬂ Start 3Com Bluetooth Connection Manager.
o1
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ﬂ Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

E] on the [Tool] menu, click [COM port].

ﬂ Check that the message “Bluetooth Serial Client (COMXx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B click [Close].

B On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
B Click the [Ponts] tab.

[ﬁ] Under [Port], select the [COMx:] check box. X indicates the COM port number
used by Bluetooth.

0 ctick [ok1.
Close the [Printers] window.

@ Note

O To always use the same printer, select the [Always use for this connection]
check box.

O System requirements vary depending on the Bluetooth standard and spec-
ifications. For details, see the manuals supplied with each product.

O For information about setting up Bluetooth under other operating systems
or using it with different utilities, see the manuals supplied with those op-
erating systems or utilities.

O If a dialog box appears while transmitting a print job, reestablish network
connection as follows:

@ Select the printer you want to use in the [Printers and Faxes] box.
@ Click [Connect].

p Reference

For details, see the manuals supplied with the Bluetooth adaptor or com-
puter equipped with Bluetooth.
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Configuring Security Mode Settings

This describes how to coufigure the security mode settings.
ﬂ Start 3Com Bluetooth Connection Manager.

ﬂ On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

8 Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.53 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals supplied with the utility.

O click [ok.
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.53 “Printing in the Security Mode”.

Printing in the Security Mode

This describes how to print in the security mode.

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

ﬂ The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.
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Preparing the Machine

Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

/O Reference

For details about making option settings for the printer, see p.56 “If Bidirec-
tional Communication Is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.

* Bidirectional communication is supported by Windows 95 / 98 / Me / 2000 / XP,
Windows Server 2003, and Windows NT 4.0.

¢ If you use the RPCS printer driver and bidirectional communication is ena-
bled under Windows 2000, the [Change Accessories] tab is unavailable.

& Note

O The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

O The PCL printer driver supports bidirectional communications. You can up-
date the machine status manually.

To support bidirectional communication, the following conditions must be met:

% When connected with parallel cables
* The computer must support bidirectional communication.
¢ The machine must support bidirectional communication.
¢ The interface cable must support bidirectional communication.

* The machine must be connected to the computer using the standard paral-
lel cables and parallel connectors.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
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< When connected with the network
¢ The machine must support bidirectional communication.

e SmartDeviceMonitor for Client included on the CD-ROM must be in-
stalled, and TCP/IP must be used.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.

¢ In addition to the above, one of the following conditions must also be met:

¢ The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

¢ The standard TCP/IP port must be used without changing the default
port name (for Windows 2000 / XP and Windows Server 2003).

* Microsoft TCP/IP print IP address must be specified for use (for Win-
dows NT 4.0).

¢ IPP port name must include the IP address when using the IPP protocol.

< When connected with IEEE 1394

* The computer must support bidirectional communication.

¢ The machine must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.

* [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate] must
be selected in the Bidi-SCSI print.

e Under Windows 2000 / XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [Ports] tab with RPCS printer driver.

% When connected with USB
The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

& Note
O Install SmartDeviceMonitor for Client from the supplied CD-ROM.
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If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communications are disabled.

ﬂlmportant

O Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] (Windows 2000) or [Printers and Faxes] (Win-
dows XP / Windows Server 2003) folder. Log on as an Administrators or
Power Users group member.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

When using Windows XP or Windows Server 2003, point to [Settings] on the
[Start] menu, and then click [Printers and Faxes]. The [Printers and Faxes] win-
dow appears.

g Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

B Select options installed from the [Options] area, and then make the neces-
sary settings.

B Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

ﬂ Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from the targets of
automatic tray selection.

8 Click [OK] to close the printer properties dialog box.



Installing Font Manager 2000

Installing Font Manager 2000

ﬁklmportant

O Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, in-
stalling applications by Auto Run requires administrator permission. To in-
stall a printer driver by Auto Run, log on using an account that has
administrator permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

The installer starts.
B Click [Font Manager 2000].

ﬂ Follow the instructions on the screen.
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Preparing the Machine

Using Adobe PageMaker Version 6.0, 6.5,
or7.0

Under Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, or Windows
NT 4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker
folder.

PPD files have the .ppd extension in the folder “DRIV-
ERS\PS\WIN9X_ME\ (Language)\DISK1” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95 / 98 / Me.
Use the folder that is appropriate for the operating system you are currently us-
ing.

The third folder “(Language)” may be substituted by an appropriate language
name.

Copy the .ppd file to the PageMaker folder.

* For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4".

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

¢ For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

& Note
O If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

O When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.

@® On the [File] menu, click [Print].
The [Print Document] dialog box appears.

® Make the necessary settings in the [Features] box.
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2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95 /98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Make the necessary settings, and then click [OK].

@ Note

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

/O Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

& on the [File] menu, click [Print].

The [Print] dialog box appears.
ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.
59
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Setting Up the Printer Driver

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

p Reference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

iﬁklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

g Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

p Reference
For details, see the printer driver Help.

o1



62

Setting Up the Printer Driver

Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list, and then click
[Preferences].

B Make the necessary settings, and then click [OK] to start printing.

4 Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.

64 ﬂ Make the necessary settings, and then click [OK].
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& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
O crick [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.

65



66

Setting Up the Printer Driver

RPCS - Accessing the Printer Properties

Windows 95 /98 / Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

% Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

% Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬂlmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

4 Note

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

A Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.
ﬂ On the [File] menu, click [Print].

The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
O crick [OK] to start printing.

@ Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

[I On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

Bon the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
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B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

8 Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

/O Reference
For details, see the printer driver Help.
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S
3. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the machine for printing, without having to
open a PDF application.

ﬂlmportant
O This function is possible only when the optional PostScript 3 unit is installed.

O This function is possible for genuine Adobe PDF files only.

O Version 1.3, 1.4, and 1.5 PDF files are compatible.

O Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.

O PDF version 1.5 exclusive functions are not compatible.

O High Compression PDF files created using the machine's scanner function
cannot be printed directly.

& Note
O Paper size errors may occur when printing on custom size paper.

Printing Method

The following are the two methods of printing the PDF files directly, either using
the DeskTopBinder Lite, or entering commands.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite
ﬂ Quit all applications currently running.

Fd 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work under certain operating system settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

B Select an interface language, and then click [OK].
ﬂ Click [DeskTopBinder-SmartDeviceMonitor for Client] , and then click [Next >].

B Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.
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DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files di-
rectly.

ﬂ On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

g When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function3] screen appears.

B On the [Printing Function3] screen, click [Add] to display [PDF Direct Print Prop-
erties].

ﬂ Select Driver for This Machine, click [OK], and then click [Next] repeatedly
until [Finish] is displayed.

Click [Finish].

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

ﬂ On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].
An icon for the Function palette is added to the task tray displayed at the bot-
tom right of the screen.

g Right-click the icon that is added to the task tray, and then click [Properties]
to display the Properties screen.

B Click the [Contents] tab, select the [PDF Direct Print] check box at the center,
and then click [OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

PDF Direct Printing

Use the method below to print PDF files directly.

ﬂ Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

ﬂ [Output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.
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Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

[I In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

ﬂ When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function3] screen appears.

8 On the [Printing Function3] screen, click [Properties] to display [PDF Direct Print
Properties].

ﬂ Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].

Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

B Move the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

[ [output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

ﬂ The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password]
field at the bottom right of the screen, and then click [OK].

The password-protected PDF file is printed.

& Note
O Before printing a password-protected PDF file, perform one of the following;:
* Enter the PDF password in the PDF Direct Printing Properties screen

* Specify a PDF password by selecting [Change PDF Password] in the [PDF
Menu] menu on the control panel of this machine.

O If a [PDF Group Password] for the [PDF Menu] menu is assigned to either
DeskTopBinder Lite or the control panel of this machine, the same group
password needs to be assigned to the other.
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PDF Direct Print Properties

Hachine ID: 2650533062

[ Carcel |

Hep |

1. Setting name:

Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...

Changes the icon displayed on the tool bar.

3. Printer

Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex

Prints on both sides of sheets.

5. Layout
Prints multiple pages on a single sheet.

6. Punch

Punch holes in output sheets.

7. Staple
Staple together output sheets.

8. Display this dialog box before
printing

Appears in PDF direct printing mode if
this check box is selected.

9. Orientation:
Specify the original's orientation.

AMUO10S

10. Number of copies
Specify the number of copies to print.

11. Collate
Sorts printed sheets.

12. Range

Specifies the print area on each page.

13. Printout Paper Size
Specify the paper size you want copies to
be printed onto.

14. Color/Black and White:
Specifies color or black-and-white printing.

15. Resolution:
Specifies a print resolution.

16. PDF password:

Enter the password for password-pro-
tected PDF files. A password-protected
PDF file cannot be printed unless its pass-
word is entered here.

17. Group password:

If a group password is assigned to Desk-
TopBinder Lite and this machine, enter
the group password in this field. The
group password must be entered for
printing to start.



Printing a PDF File Directly

Using commands

You can print PDF files directly, using commands such as “ftp” “sftp”and “Ipr”.

ye Reference
For details about UNIX commands, see Network Guide.
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Unauthorized Copy Control

You can embed patterns and text under printed text to prevent unauthorized
copying of the document. Unauthorized Copy Control consists of two functions:
[Data security for copying] and [ Mask type:].

ﬂlmportant
O This function is designed to discourage copying of confidential documents; it

does not prevent unauthorized use of information.

Opening the Unauthorized Copy Control Window

ﬂ In the RPCS printer driver, open the [Printing Preference] window.
B click [Add/iChange Custom Settings...].
B Select the [Unauthorized copy...] check box.

ﬂ Click [Control Settings...].
The Unauthorized Copy Control window appears.

¢ Note
O For details, see the printer driver Help.

Using [Data security for copying]

You can embed a print pattern by setting it in the printer driver.

‘E, Unavtharized copy prevention: Test
Text
T R
LA Fort  Sielponty)

[Aral N s H|r

Fotswlee  Ange

[Fequiar s | 4 T ouine
r

iz 1l 4
0 | Concel | | Restore Defauts

% Setting [Data security for copying] in the printer driver

e Select the [Data security for copying] checkbox. You can also enter the text in
the [ Text:] box.

* You cannot select the [ Mask type:] checkbox at the same time.

e To print a document protected by gray overprint, the machine must be set
up correctly. Consult your administrator.
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% Printing a document using [Data security for copying]

1 2 3

=

AJLO30S

1. The pattern and text you have set 3. The document is blanked by gray
is printed. overprint.

2. The document is copied or stored
in copiers / multifunction machines
which the optional Copy Data Secu-
rity unit is installed.

@ Note

O When printing a document that is set with [Data security for copying], the ma-
chine does not require the optional Copy Data Security unit to be installed.
The Copy Data Security unit is required when copying or storing a document
protected by gray overprint.

O Only the RPCS printer driver is supported.
O Printing at 200 x 200 dpi is not possible.
O You cannot partially embed a pattern and text in a document.

O To make the embedded pattern clear, set the character size at least 50 pt
(preferably70 to 80 pt) and character angle to between 30 and 40 degrees.

[ Use 182 x 257 mm (7!/4 x 10!/ in.) or larger paper.

O Use ordinary or recycled paper of at least 70% whiteness.

O Duplex printing may interfere with this function as a result of text and pat-
terns being visible through the paper.

A Reference
For details about setting [Data security for copying], see the printer driver Help.
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Using [ Mask type:]

You can embed patterns and text in a document by setting in the printer driver

to prevent unauthorized copying.

d copy prevention

i

i

I~ Repeat
4 I Fiotate 180 degrees at
Carfane fellin

4 | T outine
ot i2f ™ Testonlp

Help | Restore Defauls

% Setting [ Mask type:] in the printer driver

* Select a pattern from [ Mask type:], and then enter text in the [Text:] box.
* You canselect overprint colour from [Black], [Cyan], or [Magenta] in the [ Color:]

list.
& Note

O You can set only [ Text:], but [ Mask type:] and [ Text:] must be set together.

+ Printing a document using [ Mask type:]

1 2

-

1. The pattern and text you have set
is printed palely.

2. The document is copied, scanned,
or stored in copiers / multifunction
machines.
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3. The pattern and text you have set
appear clearly.
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& Note

0

aaa

Q

0

Only the RPCS printer driver is supported.
Printing at 200 x 200 dpi is not possible.
You cannot partially embed patterns and text strings in a document.

To make the embedded pattern clear, set the character size at least 50 pt (pref-
erably 70 to 80 pt) and character angle to between 30 and 40 degrees.

Due to the effects of the settings, the results of copying, scanning, and saving
documents in the document server may vary depending on the machine
model and setting conditions.

Printing with background patterns and text may be slower than normal print-
ing.

p Reference

For details about setting [ Mask type:], see the printer driver Help.

Important Notice

The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print pat-
terns and the performance of Unauthorized Copy Control may vary depend-
ing on the quality of paper used and the machine model and settings.

The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print pat-
terns.
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Using the Print Job Function

This describes how to print files stored in the machine.

The following types of printing can be selected using the printer driver: Sample
Print, Locked Print, Hold Print, and Stored Print.

You can print or delete the print jobs saved in the machine which is sent from
computers.

If you select Sample Print, Locked Print, and Hold Print, the print files saved in
the machine are deleted after printing is completed. If you select Stored Print,
the files remain in the machine even after printing is finished.

If you press [Print Jobs] on the Printer screen, the Complete List or the List Per
User ID screen appears depending on which list type you select from [Initial Print
Job List].

Initial Print Job List Cancel K

Select item, then press [OK].

Complete List List Per User ID

« Complete List
If you select [Complete List] from [Initial Print Job List], the following screen ap-

Print Jobs Bit = 15
Select job(s).
e [0 e/t _fietn] Selected —_—14
[[® | 1236 | 08/24 16352 | New Horcbad Document by 13
[
1 ———1 st [[® 1236 08/24 1652 | New Horcbad Document hy 12
[ © | 1236 08/24 00:40 | New Worcbad Document
2 = Comelete List
3 T [ 123% 0824 00:40 | New Horpad Document
" Lcke Prnt b List
T ot Print o list_| :
S @ | 123 _ 08/24 00:40 | New Hordpad Document:
4 Sarole Prit Jo List
EE S [ 9 123 08/25 20329 | New Hordoad Document: 1
5 bt bl | (8 1234 08/25 20:29 | New Wordbad Document
|
6 TSttt WLt | 75 | 1234 08/25 20:28 | New Worcbad Docunent 10
JE—
7 = Details 2

AMU003S

@ Jobs Per User ID
Displays List Per User ID.

@ Complete List
Displays all files stored in the machine.

® Locked Print Job List
Displays only Locked Print files stored in the machine.
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@ Sample Print Job List
Displays only Sample Print files stored in the machine.
® Hold Print Job List
Displays only Hold Print files stored in the machine.
® Stored Print Job List
Displays only Stored Print files stored in the machine.
@ Details
Displays details about a selected file.
[4Previous] / [V Next]
If the list of files does not fit on the screen, scroll down to view the list.

® [Delete]
Deletes a selected file.

[Print]
Prints a selected file.

@ [Change Password]
Changes or deletes the password of a file if a password is set. To change
the password, press [Change Password], enter the current password, and
then enter the new password on the confirmation screen. To delete the
password, press [Change Password], leave the entering/confirming a new
password box blank, and then press the [OK] key.
You can also set passwords to the Stored Print files that do not currently
have passwords.

® [Clear All]
Clears all selections.

® [Select All Jobs]
Selects all files stored in the machine.

Selected:
Displays number of the files selected.

® [Exit]
Returns to the Printer screen.

User ID, Date / Time: , and File Name: display
Displays the time when the instruction to print the stored files was entered,
the User IDs, and the file names.
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+ List Per User ID
If you select [List Per User ID] from [Initial Print Job List], the following screen appears:

1 2
Print Jobs [ &t —3
Select User I
Alliobs for t]- selected user ID willbe printed.
Cex | Comolete st e 4}
I Tom | ow | I List Per Lser ) e 55
Print All kbs e ()

AMU004S

® User ID
Displays the User IDs who sent files to the machine.

@ [Clear]

Deselects a selection.

® [Exit]

Returns to the Printer screen.
@ [Complete List]
Displays all print jobs.
® [List Per User ID]
Displays the print job list of each ID.

® [Print All Jobs]
Prints all selected type of files sent by the user ID.

@ [4aPrevious] / [V Next]
If the list of files does not fit on the screen, scroll down to view the list.

@ Note

O Multiple files can be selected on the Print Jobs screen. To clear selection, press
the selected print jobs again.

O The display is not updated if a new file is stored while the list of stored files
is displayed. To update the display, press [Exit] to return to the Printer
screen, and then press [Print Jobs] again.

O If a large number of print jobs is stored in the machine, processing may slow
temporarily, depending on which functions are used.

O If you press [List Per User ID] in the Complete List screen, the screen switches
to the List Per User ID screen where [Back] appears at the bottom right. Press
[Back] to switch to the Complete List screen.



Using the Print Job Function

A Reference
p-88 “Sample Print

p-91 “Locked Print”
p-94 “Hold Print”
p.97 “Stored Print”

7

Selecting the Initial Print Job List

Follow the procedure below to set the initial Print Jobs screen, and to show it.

Selecting the Initial Print Job List

ﬂ Press the [ User Tools/Counter] key.

EI Press [Printer Features].
The Printer Features menu appears

EJ On the [System] tab, press [Initial Print Job List].
O select either [Complete List] or [List Per User ID].

Initial Print Job List Cancel K

Select item, then press [OK].

Corrplete List: List Per User ID

After configuring the settings, the selected type of print job list is displayed.

Displaying a Print Job List

B press [Print Jobs].

£ PrPaper Tray Status

A4 A4 A3

H Offline

Job Reset ‘ ‘ Print Jobs | | E

P b Lists & Error Log

Either the Complete List or List Per User ID screen appears.
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Printing from the Print Job Screen

Explains Sample Print, Locked Print, Hold Print, and Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you
have checked the result, remaining sets can be printed or canceled using the ma-
chine's control panel. This can reduce misprints due to mistakes in content or
settings.

ﬂlmportant

0

A Sample Print file cannot be stored if:

* the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 2,000 pages in total.

@ Note

0

0

If a Sample Print file has not been stored properly, check the error log on the
display panel.

Even after you turn off the machine, stored documents in the machine re-
main. However, the [Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print
Jobs] settings are applied first.

If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Sample Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's [Print] dia-
log box, more prints than intended may be produced.

If the first set of the Sample Print files is not as you expected and you do not
want to print remaining sets, delete the Sample Print file using the display
panel. If you print the remaining sets of the Sample Print file, the job in the
machine is deleted automatically.

p Reference

For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.
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Printing a Sample Print File

The following procedure describes how to print a Sample Print file with the PCL
6 / 5c and the RPCS printer driver. For information about how to print a Sample
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement in-
cluded as a PDF file on the CD-ROM.

iﬁklmportant

O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Sample Print in the printer driver's properties.
For details about configuring the printer drivers, see the relevant Help files.

ﬂ Start printing from the application's [Print] dialog box.
Make sure to set more than two copies.
The Sample Print job is sent to the machine, and the first set is printed.

B On the machine's control panel, press the [ Printer] key to display the Printer
screen.

O press [Print Jobs].

% o | B-Paper Tray Status
10200314
HrO7fline A4 A4 A3

P lob Lists & Error Log

Joh Reset ‘ ‘ Print Jobs | | E

A list of print files stored in the machine appears.

B Press[Sample Print Job List].

Print Jobs Exit

Select job(s).
All Jobs

User ID Date / Time  File Name Selected: 0
B | 8888 | 08/24 16:57 | New Horcbad Docunent
Jobs Per User D ® | 1234 | 08/24 16:52 | New Horcbad Docunent

[ 1234 08/24 16:52 | New Wordpad Document

Complete List
& Locked Print Job List

[ Sanple Print Job List

(3 Fold rint Jb List
9 Store Print Job List

Detalls 1”1

A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.
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E Select the file you want to print, and press [Print].

Prnt Jobs et ]

Select job(s).

s UserlD  Date/Time _File hame Selected: i
© 8888 | 08/24 16357 New Worcpad Docunent | | Select All obs

Jobs Per User ID © | 1254 | 08/24 16:52 | New Worcbad Docunent | Clear All

[ comitelst_| [ 133 | 08/2 1652 New Worchad Docunent

53 Stored Print Job List Print.
Details ”n Delete
1500 200
Syt 16:53

ﬂ Enter the new number of sets using the number keys.

@ Are you sure you want to print
the following?

User ID: 1234
File Name: New Wordpad Document

The set auantity can be changed.
> 2 <1999

Job List:

You can enter up to 999 sets.
Press [ Clear/Stop] to correct any entry mistakes.

B Press [Yes].
The remaining sets are printed.
Press [Stop] to cancel printing.

& Note
O If you select multiple files, the confirmation screen displays the total
number of files to be deleted.

O If you select multiple documents and do not specify the number of sets on
the confirmation screen, one set less than the number specified on the com-
puter is printed for every selected document. If the number of sets speci-
fied on the computer is “1”, one set each is printed for every document.

O When printing accumulated sample print documents, you cannot change
the numbers of sets.

O When printing is completed, the stored file will be deleted.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.
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Deleting Sample Print Files

If you are not satisfied with the sample printout, you can delete the Sample Print
file, revise it and print it again until the settings are suitable.

0 press the [Printer] key to display the Printer screen.

B press [Print Jobs].
A list of the print files stored in the machine appears.

B Press [Sample Print Job List].
A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and then press [Delete].
The delete confirmation screen appears.

B Press [Yes] to delete the file.
The selected file is deleted.

& Note
O If you do not want to delete the file, press [No].

O If you select multiple files, the confirmation screen displays the total
number of files to be deleted.

Locked Print

Use this function to maintain privacy when printing confidential documents on
the machine over a shared network. Usually, it is possible to print data using the
display panel once it is stored in this machine. When using Locked Print, it is not
possible to print unless a password is entered on the machine's display panel.
Your confidential documents will be safe from being viewed by other people.

ﬂlmportant
O A Locked Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 2,000 pages in total.

& Note

O If a Locked Print file has not been stored properly, check the error log on the
display panel.

O Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print Jobs] settings are
applied first.
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O If the application has a collate option, make sure it is not selected before send-
ing a print job. Locked Print jobs are automatically collated by the printer
driver as default. If a collate option is selected in the application print dialog
box, more sets than intended may be printed.

O After the Locked Print file is printed, the job is automatically deleted.

A Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.

Printing a Locked Print File

The following procedure describes how to print a Locked Print file with the PCL
6/5c and the RPCS printer driver. For information about how to print a Locked
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement in-
cluded as a PDF file on the CD-ROM.

ﬂlmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure the Locked Print in the printer driver's properties.

For details about configuring the printer drivers, see the corresponding Help
files.

ﬂ Start printing from the application's [Print] dialog box.
The Locked Print job is sent to the machine.

B On the machine's control panel, press the [ Printer] key to display the Printer
screen.

ﬂ Press [Print Jobs].

E P-Paper Tray Status
1022310
HrOfline A4 A4 A3

P-lob Lists & Error Log

T

Job Reset ‘ ‘ Print Jobs | | E

A list of print files stored in the machine appears.



Printing from the Print Job Screen

B Press [Locked Print Job List].

Prnt Jobs [ et

Select job(s).

All Jobs User ID Date / Time  File Name Selected: 0

1B 1230 | 08/23 2021 | seesmemenssnenss |
JbsPerlser D | (3@ 1256 08/25 20:19 | seessersesenne |

Complete List
9 Sanele Print lob List
(34 Hold Print Job List
53 Stored Print Job List

Details i

A list of Locked Print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

B Select the file you want to print, and then press [Print].

I
Print Jobs et ]
Select job).
[ hiEE ] leP  0ste/Tme Feam Selected 1
18] 136 |8/ 2020 | [ Select All ks |
JotsPerUser 0| (TSN 254 08/23 20:19 | mexxmmonxnsmnnns Clear AlL
Cormplete List
(& e print o List |
(@ Sample Print Job List
(31 Hold Print Job List Change Password
43 Stored Print Job List Print

[T ” [ e |
Systen Status || Job List 15wy 2

The password screen appears.

ﬂ Enter the password using the number keys, and then press [ 0K].

@ Enter the password with the Number keys,
then press [OK].

Cancel

The print confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly.
Press [Exit] to enter the password again.

If multiple print files are selected, the machine prints files that correspond to
the entered password. The number of files to be printed is displayed on the
confirmation screen.

If you forgot your password, ask your network administrator for help.
B Press [Yes).

The locked file is printed.
Press [Stop] to cancel printing.
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& Note
O When printing is completed, the stored file will be deleted.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.

Deleting Locked Print Files

ﬂ Press the [ Printer] key to display the Printer screen.
g Press [Print Jobs].

EJ Press [Locked Print Job List].
A list of Locked Print files stored appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and then press [Delete].

The password screen is displayed.

B Enter the password using the number keys, and then press [OK].
The delete confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly.
Press [EXit] to enter the password again.

If you forget your password, ask your network administrator for help.

B Press [Yes].
The selected file is deleted.
If you do not want to delete the file, press [No].

& Note

O If multiple print files are selected, the machine deletes files that correspond
to the entered password. The number of files to be deleted is displayed on
the confirmation screen.

Hold Print

Use this function to temporarily hold a file in the machine, and print it from the
computer or the machine's control panel later.

ﬂlmportant
O A Hold Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 2,000 pages in total.
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& Note

O If a Hold Print file has not been stored properly, check the error log on the dis-
play panel.

O Even after you turn off the machine, stored documents in the machine re-
main. However, the [Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print
Jobs] settings are applied first.

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Hold Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

A Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.

Printing a Hold Print File

The following procedure describes how to print a Hold Print file with the PCL
6/5c and the RPCS printer driver. For information about how to print a Hold
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement in-
cluded as a PDF file in the supplied CD-ROM.

ﬂlmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Hold Print in the printer driver’s properties.
For details about configuring the printer drivers, see the relevant Help files.

ﬂ Click [Details...], and then enter a User ID in the [User ID:] box.

B Start printing from the application’s [Print] dialog box.
The Hold Print job is sent to the machine and stored.

ﬂ On the machine’s control panel, press the [Printer] key to display the print-
er screen.
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B press [Print Jobs].

; PPaper Tray Status
| | 1020314
M Offline A4 A4 A3
P oy Lists & Frrar Log
Joh Reset ‘ ‘ Print Jobs || E

(3 press [Hold Print Job List].

Print Jobs Exit
Select job(s).
A Jobs User ID Date / Time  File Name. Selected 0

G 1234 08/24 17:21 | New Wordoad Document

Jobs Per User D Br | 1234 |08/24 17:21 | New Hordoad Document

B | 1234 | 08/24 17:19 | New Hordbad Docunent
Cormplete List 1
G 1234 08/24 17:19 | New Wordoad Docunent
& Locke Print ob List
) Sanole Print Jo List

[ rint o it

9 Store Print Job List
Details "

System Status || Job List

A list of a print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to print, and press [Print].

Print Jobs Exit
Select jobl(s).
S UserD  Date/Time FileName Selected: 1
B | 1234 | 08/24 17:21 | New Hordoad Docunent Select All Jobs

Jobs Per User D BV | 1234 | 08/24 17:21 | New Worchad Docunent Clear All

G 1234 08/24 17:19 | New Wordoad Docunent
Complete List
B' | 1234 | 08/24 17:19 | New Hordbad Docuent
& Locked Print ob List
9 Sanele Print lob Lst

21 Hald Print b List

53 Store Print Job List Print.
Details ”n Delete

System Status Job List.

The confirmation screen appears.

B press [Yes).
The Hold Print file is printed.
Press [Stop] to cancel printing.

& Note
O When printing is completed, the stored file is deleted.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.

O If you select multiple files, the confirmation screen displays the total
number of files to be deleted.



Printing from the Print Job Screen

A Reference
For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Hold Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.

Deleting Hold Print Files

0 press the [ Printer] key to display the Printer screen.

B press [Print Jobs].
A list of print files stored in the machine appears.

EJ Press [Hold Print Job List].
A list of a Hold Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and then press [Delete].
The delete confirmation screen appears.

B Press [Yes] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [No].

If you select multiple files, the confirmation screen displays the total number
of files to be deleted.

Stored Print

Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later. Jobs are not deleted after they are
printed, so the same job need not be re-sent in order to print multiple copies.

ﬂlmportant
O A Stored Print file cannot be stored if:

* the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 2,000 pages in total.

@ Note

O If a Stored Print file has not been stored properly, check the error log on the
display panel.

O Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print Jobs] settings are
applied first (see “Printer Features”, General Settings Guide).
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O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Stored Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

O You can optionally set a document title and a password of a Stored Print file.
For details about a password setting, see the printer driver Help.

A Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.

For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “Printer Features”, General Settings Guide.

Printing a Stored Print File

The following procedure describes how to print a Stored Print file with the PCL
6/5c and the RPCS printer driver. For information about how to print a Stored
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement in-
cluded as a PDF file on the supplied CD-ROM.

iﬁklmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Stored Print in the printer driver’s properties.
You can select two methods of Stored Print:

e [Stored Print]
Stores the file in the printer and print it later using the display panel.

e [Store and Normal Print]
Prints the file at once and also stores the file in the machine.

For details about configuring the printer drivers, see the relevant Help files.

ﬂ Click [Details...], and then enter a User ID in the [User ID:] box.
You can also set a password. The same password must be entered when print-
ing or deleting.

B Start printing from the application’s [Print] dialog box.
The Stored Print job is sent to the machine and stored.

ﬂ On the machine’s control panel, press the [Printer] key to display the Print-
er screen.



Printing from the Print Job Screen

B press [Print Jobs].

; PPaper Tray Status
| | 1020314
M Offline A4 A4 A3
P oy Lists & Frrar Log
Joh Reset ‘ ‘ Print Jobs || E

B Press [Stored Print Job List].

Print Jobs Exit

Select job(s).

User ID Date / Time  File Name. Selected 0
2 1234 08/24 17:28 | New Wordoad Document

Jobs Per User D S| 1234 | 08/24 17:27 | New Hordoad Document

2 1234 08/23 20:29 | New Wordpad Document
Complete List
& Locked Print Job List
[ Sanple Print Job List
[ Hold Print Job List

[ Sord rnt o it

Detalls 1”1

All Jobs

System Status || Job List

A list of Stored Print files stored in the machine appears.

ﬂ Select the file you want to print, and press [Print].

Print Jobs. Exit
Select job(s).
User ID Date / Time _ File Name Selected: 1

S| 1234 | 08/24 17:28 | New Hordbad Docunent Select All Jobs

Jobs Per User ID S| 1234 | 08/24 17:27 | New Worcbad Docunent Clear All

@ S| 1234 108/25 20:29 | New Hordoad Document
(31 Bold Print Job List Change Password

3 Store Print Job List Print.

All Jobs

Details 7 Delete

Status Job List.

The confirmation screen appears.

If you set a password in the printer driver, a password confirmation screen
appears. Enter the password.

If multiple print files are selected, and some of these require a password, the
machine prints files that correspond to the entered password and files that do
not require a password. The number of files to be printed is displayed on the
confirmation screen.

If you forget your password, ask your network administrator for help.
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B Enter the number of sets using the number keys.

@ Are you sure you want to print
the following?

User ID: 1234
File Name: New Wordpad Document

The set auentity can be chanced.
> _2 <999

You can enter up to 999 sets.
Press [ Clear/Stop] to correct any entry mistakes.

g Press [Yes].
The Stored Print file is printed.
Press [Stop] to cancel printing.

4 Note

O If you select multiple files, the confirmation screen displays the total

number of files to be printed.

O If you select multiple documents, set numbers are determined based on the
smallest set number specified for a selected document.

O When printing accumulated stored print documents, you cannot change

the numbers of sets.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. A Stored Print file is not deleted

even if [Job Reset] is pressed.

O Stored Print files that are sent to the machine are deleted only if you select
[Auto Delete Stored Print Jobs] or select them for deletion. (see “Printer Fea-

tures”, General Settings Guide).

/O Reference

For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Stored Print file from Web Image Monitor. For de-

tails, see Web Image Monitor Help.



Printing from the Print Job Screen

Deleting Stored Print Files

0 press the [Printer] key to display the Printer screen.

B press [Print Jobs].
A list of print files stored in the machine appears.

B Press [Stored Print Job List].
A list of Stored Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and press [Delete].
The delete confirmation screen appears.
If you set the password in the printer driver, enter the password to delete.

If multiple print files are selected, and some of these require a password, the
machine deletes files correspond to the entered password and files that do not
require a password. The number of files to be deleted is displayed on the con-
firmation screen.

If you forgot your password, ask your network administrator for help.

B Press [Yes] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [No].

& Note
O If you select multiple files, the confirmation screen displays the total
number of files to be deleted.
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Printing from the Jobs Per User ID Screen

This describes how to print the files saved in the machine from the User ID
screen.

Printing the Selected Print Job

ﬂ Press the [ Printer] key.
The Printer screen appears.

ﬂ On the Printer screen, press [Print Jobs].
[

T

B-Paper Tray Status
10200310
HpOFFline A4 A4 A3

B loh Lists & Error Log

Job Reset ‘ ‘ Print Jobs | | E

A list of user IDs whose files are stored in the machine appears.

B Press the user ID whose file you want to print.

Print Jobs Exit
Select User ID
Al obs for the selected user D will b printed.
Clear Complete List
3588 List Per User ID

Print All Jobs

7 Back

You cannot select multiple user IDs at the same time.
Press [4Previous] or [YNext] to scroll through the list.
Press [Clear] to cancel a selection.



Printing from the Jobs Per User ID Screen

O Press [List Per User ID].

Exit

List Per User 1D

The print job list of the selected user ID appears.
B Select the desired print jobs.

Print Jobs Exit

Select job(s).

All Jobs User ID Date / Time  File Name Selected:

3888 D 8888 | 08/24 17:34  New orcbad Docunent |
|| Jobs Per User 1D Bt 6888 | 08/24 17:34  New Horcbad Document |
1B 8888 | 08/24 17:33 | wemmmmnnnnnnnnes ‘

6868 | 08/264 17:52  New Horcbad Document |

| CompleteList
& Locked Print Job List
(39 Sample Print Job List
[1 Hold Print Job List
4 Stored Print Job List

Details ”n

To cancel a selection, press the highlighted print job again. To clear all selec-
tions, press [Clear All].

B Press [Print].
The confirmation screen appears.

U press [Yes].
The selected files are printed.

& Note

O If you select multiple files, the confirmation screen displays the total
number of files to be deleted.
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Printing All Print Jobs

ﬂ Press the [Printer] key.
The Printer screen appears.

ﬂ On the Printer screen, press [Print Jobs].

% | B-Paper Tray Status
1020314
M Offline A4 A4 A3
P lob Lists & Error Log
Joh Reset ‘ ‘ Print Jobs || E

System Statu

A list of user IDs whose files are stored in the machine appears.

B Press the user ID whose file you want to print.

I
print kbs Bit
Select User D
AL jobs for the selected user D will b printed.

Clear Complete List
o a1 List Per User ID
rint A Jobs

n Back

You cannot select multiple user IDs at the same time.
Press [4Previous] or [YNext] to scroll through the list.
Press [Clear] to cancel a selection.

O3 press [Print All Jobs].

List Per User 1D

Print ALL Jobs

15 NOW 2008

System Status 17:32

If the selected user ID has multiple types of print jobs, the selection screen of
the print job type appears.
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B Select the desired print job type, and then press [OK].

@ To print all jobs for the selected user ID,
select the job type(s), then press [OK].

Locked Print Jobs. [ Smvleintdbs |

Holdprintkbs | [ StoredPrint Jbs |

Cancel oK

The confirmation screen appears.

The confirmation screen does not appear if the selected ID has only one type
of print job.

(3 press [ves.
The selected files are printed.

& Note

O After printing is completed, Sample Print, Locked Print, and Hold Print
files are deleted.

O You cannot select a print job that is not stored under the selected user ID.

O If you select multiple Sample Print files and do not specify the number of
sets on the confirmation screen, one set less than the number specified on
the computer is printed for every selected document. If the number of sets
specified on the computer is “1”, one set each is printed for every docu-
ment.

O If you select Sample Print including multiple files without setting a quan-
tity, 1 page less than the minimum number of all settings is applied.

O If you select Stored Print, the number you set on the confirmation screen is
applied to all files of the selected print job type. If you do not set a quantity,
the minimum number is applied to all files.

O If you select Locked Print, enter the correct password. If there are multiple
passwords, the machine prints only files that correspond to the entered
password.

O If you select Stored Print files, and some of these require a password, the
machine prints files that correspond to the entered password and files that
do not require a password.

O The confirmation screen displays the total number of files that have the se-
lected user ID to be printed.
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Form Feed

This section gives instructions for operating the machine when there is no tray
for the selected paper size or type, or when paper loaded in the machine has run
out.

ﬂlmportant
O The tray cannot be changed if the following functions are set:

e Staple
¢ Punch
¢ Duplex Print to a tray that does not support duplex printing
e Cover Sheet
¢ Front and Back Covers
¢ Slip Sheet
¢ Chaptering
& Note

O If form feed is selected for a tray with the following settings, you can change
the tray by canceling the settings:

e Staple
e Punch
* Duplex Print

O If Auto Continue is selected, form fed paper is printed after a set interval. See
“Printer Features”, General Settings Guide.

Printing from a Selected Tray

If the machine does not have a tray for the selected paper size or paper type, or
if the selected paper loaded in the machine has run out, a caution message ap-
pears. If this message appears, do the following procedure.

ﬂ Press the [ Printer] key.

ﬂ Select the tray for form feed from those that appear on the display panel.
If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

B Press [Continue].

The machine prints using the selected tray.

4 Note

O If a tray with a smaller paper size is selected, the print job may be cut short,
or other problems may occur.



Form Feed

Canceling a Print Job

Follow the procedure below to cancel a print job if the message prompting form
feed appears.

ﬂ Press the [Printer] key.
The Printer screen appears.

Ed Press [Job Reset].
Delete the stored print jobs, and then cancel form feed.

8 Press [Reset the Job] to cancel the current print job, or [Reset All Jobs] to cancel
all jobs.

A confirmation message appears.

ﬂ Press [Yes] to cancel the print job.
Press [No] to return to the previous display.

& Note
O To resume printing print jobs, press [Resume Printing]

O If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

O Under Windows, if the machine is connected to the computer using a par-
allel cable, sent print jobs may be canceled if [Reset All Jobs] is pressed
while “Waiting...” is on the display panel. After the interval set in [I/O Time-
out] in Printer Features has passed, the next print job can be sent. A print
job sent from a different client computer will not be canceled in this case.

O You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [Job Reset] or
the [ Clear/Stop] key.

O A print job containing a large volume of data may take considerable time
to stop.

A Reference
For details, see p.108 “Canceling a Print Job”.
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Canceling a Print Job

This section gives instruction to stop printing from the computer or the display
panel.

Canceling a Print Job Using the Control Panel

ﬂ Press the [ Printer] key.
The Printer screen appears.

EJ press [Job Reset].

: g PPaper Tray Status
10203310

P b Lists & Error Log

Job Reset ‘ ‘ Print Jobs | | E

B Press [Reset the Job] or [Reset All Jobs].

@ [Job Reset] has been pressed.
The following job has been suspended.

Name:
User ID: 8888
File Name: New Wordpad Document

| Reset the Job ][ Reset ALL Jobs ] [Resume Printing]

* [Reset the Job]: cancels the print job currently being processed.
* [Reset All Jobs]: cancels all jobs in the print queue.

* [Resume Printing]: resumes printing print jobs.

A confirmation message appears.

ﬂ Press [Yes] to cancel the print job.
Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not com-
pleted.

ﬂ Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

g Select the name of the job you want to cancel.

B On the [Document] menu, click [Cancel].

O press the [ Printer] key on the machine's control panel.

& Note

0

0

If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

If the machine is connected to the computer using a parallel cable, sent
print jobs may be canceled if [Reset All Jobs] is pressed while “Waiting...”
is on the display panel. After the interval set in [I/O Timeout] in Printer Fea-
tures has passed, the next print job can be sent. A print job sent from a dif-
ferent client computer will not be canceled in this case.

Under Windows XP, Windows Server 2003, or Windows NT 4.0, click [Can-
cel] on the [Document] menu.

Under Windows 95 / 98 / Me / 2000 or Windows NT 4.0, you can also
open the print job queue window by double-clicking the machine icon in
the [Printers] machine window (the [Printers and Faxes] window under Win-
dows XP and Windows Server 2003).

You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [Job Reset].

A print job containing a large volume of data may take considerable time
to stop.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

ﬁklmportant

O The most recent 30 errors are stored in the error log. If a new error is added
when there are 30 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.

The error is stored separately until the number of those errors reaches 30. You
B can check any of these print jobs for error log information.

¢ Sample Print
e Locked Print
e Hold Print

e Stored Print

O If the main power switch is turned off, the error log is deleted.

ﬂ Press the [ Printer] key.
The Printer screen appears.

EI Press [Error Log].

B-Paper Tray Status

1UD2003Uz4UD 0
A4 A4 A3 A3 A4

B Job Lists & Error Log

Print Jobs

An error log list appears.

Depending on the security settings, certain errors may not be displayed.

8 Press the desired job list.

You can select job list from [Complete List], [Locked Print Job List], [Sample Print
Job List], [Hold Print Job List], or [Stored Print Job List].

ﬂ Select the print file you want to check, and then press [Details].
A detailed error log appears.

Press [APrevious] or [Y Next] to scroll the error files.
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& Note
O Press [Exit] after checking the log.

O Press [Back to List] to return to the error log list.

O To print files that appear in the error log, resend them after stored files
have been printed or deleted.

O [Error Log] is not available in simplified display mode. To view the error
log, you must first switch to normal display mode by pressing [ Simplified
Display] to turn into the nomal display mode.
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Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

ﬂlmportant

0

During Spool Printing, the hard disk is accessed and the Data In indicator
blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power of the
computer or machine off during Spool Printing.

If data is sent to the machine using other protocols besides diprint, lpr, ipp,
ftp, sftp, and smb, Spool Printing cannot be performed.

Setting Spool Printing
Spool Printing can be set using telnet or Web Image Monitor.

* Using Web Image Monitor
See Network Guide or Help for more information.

¢ Using telnet
Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.

Viewing a list of spool jobs on the display panel

If Spool Printing is set, a list of spooled jobs can be viewed on the display pan-
el screen.

Press the [ Printer] key, and then press [Spooling Job List]. A list of spooled jobs
appears.

¢ Deleting jobs
Select files to be deleted, and then press [Delete].

Viewing/Deleting spool jobs in Web Image Monitor

Start Web Image Monitor and enter the machine's IP address in the address
bar. This displays the top page.

For more information, see Network Guide.

& Note

)
)
)
a

0

Up to a maximum of 150 jobs at once can be spool printed.
If Spool Printing is not set, you cannot select [Spooling Job List].
Printing the first page with Spool Printing will be slow.

The computer requires less print processing time when large amounts of data
are spooled.

Stored spool jobs can be viewed or deleted using Web Image Monitor.



User Defined Pages

User Defined Pages

Using this function, you can specify the page numbers for each input tray.

ﬂlmportant

O This function is available with the PCL 6/5c printer driver only.

O If [Document Server] is selected under [Job Type:], User Defined Page cannot be
used.

3 If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Lay-
out:] cannot be selected.

AEV044S

A Reference
For printing methods, see the printer driver Help.
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Printing with the Finisher

You can collate, staple, or punch holes in printed paper by installing the optional
finisher. Make sure you read the following precautions when using the optional
finisher.

ﬂlmportant
O Make option settings for the machine using the printer driver when bidirec-

tional communication is disabled.

O Be sure to set the paper size and paper orientation in the printer driver when
using duplex printing, booklet printing, combined printing (layout), staple
and punch functions.

O The machine can have only one of the following installed at any one time: Fin-
isher SR3000, Finisher SR3010, or Finisher SR1000.

& Note

O Depending on the application, print settings may not be enabled and printed
output may not be as expected.

O When setting Staple or Collate in the printer driver, make sure that the Collate
check box is cleared in the application's [Print] dialog box. If Collate is enabled
in the application, printing will not be as intended.

O When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.

o [f the paper jam occurred in the optional finisher, printing will restart from
the top page of the data currently being printed, or from the page where
the paper jam occurred.

¢ If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

¢ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

/O Reference

For details about duplex printing, booklet printing, or combined printing
(layout), see the printer driver Help.

For information about optional finishers, see General Settings Guide.
To remove paper misfeeds, see Trouble Shooting.



Printing with the Finisher

Staple

With the optional Finisher SR3010, Finisher SR3000 or Finisher 1000 installed,

sets can be stapled individually when printing multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and

feed orientation. The following table shows staple positions:

(I;a_pe{ o Print Data Staple Position
rientation . :
theMachine | PI'€Ction | Finisher 1000 | Finisher 3010 Finisher 3000

Portrait

RIR

RIR

)

Landscape

'R/ R]

'R/ R]

'R/ R]

Portrait

L)

Landscape

'R|R]

'R|[R]

'R|R:

'R|R:

'R HL‘

'R|R:

& Note

ANW100S

O Stapling might not be in the specified position if combine (layout) and duplex
printing are both selected. After setting the staple position, use the printer
driver's preview icon to check the position before printing.

A Reference
For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications”, General Settings Guide.

For printing methods, see the printer driver Help.
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Stapling Precautions

ﬂlmportant
O Stapling can be done only with the optional finisher installed.

+ Staple printing will be canceled under the following conditions:

If the number of pages to staple exceeds maximum.

If a paper size that cannot be stapled is selected.

If a paper type that cannot be stapled is selected.

If positions other than those fixed for stapling are specified.

If there are inconsistencies between the orientation in the duplex mode and
the staple position.

If there are inconsistencies between the orientation in letterhead mode and
the staple position.

If paper sizes are mixed when a different paper size is specified during a
print job.
When feeding paper from the bypass tray.

When staples have run out and Auto Continue is set (printing will contin-
ue without stapling after the message has been displayed).

When only 1 page is printed.
When staples have run out.

& Note
O When the stapling is cancelled, “BD: Staple has been cancelled.” appears.
O If Staple or Shift Collate is selected with the optional Finisher SR3010 or Fin-

isher SR3000, or Finisher SR1000 installed, the paper will be output to the fin-
sher shift tray irrespective of the setting.

O When printing on letterhead, stapling may not be at the specified position.

O If you cannot make staple settings even with Finisher SR3000, Finisher
SR3010, Finisher SR1000 installed, options may not be set correctly in the
printer driver. Correct option settings in the printer driver. For details, see the
printer driver Help.

O When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

O Be sure to set paper size and orientation in the printer driver when stapling.

O When duplex printing is selected, adjust staple positions to the binding orien-
tation.

O Depending on the software you are using, print settings may not be saved
and the printed result may not be as expected.

O When setting Staple in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.



Printing with the Finisher

Punch

With the optional 2 Tray Finisher installed, holes can be punched into printed
output.

Punch Position

The specified punch position varies depending on paper feed and print data ori-
entation. The following table shows punch positions:

Paper Orientation | Print Data Punch Position

on the Machine Direction 2 holes 3 holes 4 holes
e I IR :
D Portrait .R R. :R R: :R R:
Landscape .R. .ﬁ. ’ .R"
e o [ X X 0000
Portrait R R R
[ . . .
.R ‘R :R
Landscape o ° o
R. R: R:

& Note
O Punch positions will vary slightly from page to page as holes are punched
into each sheet individually.

A Reference
For information about paper sizes that can be punched, see “Supplementary
Informations”, Copy/ Document Server Reference.

For printing methods, see the printer driver Help.
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Punching Precautions

Follow these precautions when using the punch function.

ﬂlmportant
O To use this function, the optional tray Finisher SR3000 and punch unit must

be installed on the printer.

+ Punch printing will be canceled under the following conditions:
* When a paper type that cannot be punched is selected.
* When a paper size that cannot be punched is selected.
e If positions other than those fixed for punching are specified.

¢ If there are inconsistencies between the orientation in duplex mode and the
punch position.

e If there are inconsistencies between the orientation in letterhead mode and
the punch position.

* When feeding paper from the bypass tray.

* When the punch receptacle has become full and Auto Continue is set
(Printing will continue without punching after the message appears).

* If there are inconsistencies between the staple position and the punch po-
sition, when using with staple function.

& Note

O When punching is cancelled, “BE: Punch has been cancelled.” appears.

O Punching might not be in the specified position when printing on letterhead
paper.

O If you cannot make punch settings even with the optional finisher installed,

options may not be set correctly in the printer driver. Correct option settings
in the printer driver. For details, see the printer driver Help.

O When duplex print is selected, adjust the punch position to the binding direc-
tion.

O Be sure to set the punch position the same as the staple position when using
it with the staple function.

O Be sure to set paper size and orientation in the printer driver when punching.

O Depending on the application, print settings may not be enabled and printed
output may not be as expected.

O When setting Punch in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application.

O If a collate option is selected in the application, printing will not be as intend-
ed.



Printing with the Finisher

Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer to the printer memory or hard disk drive. The fol-
lowing are the three types of Collate:

ﬁ*lmportant
O If Auto Continue occurs on the first set, Collate will be canceled.

O If forced printing occurs on the first set, Collate will be canceled.

O When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

& Note
O Set Collate and Rotating collate when using the RPCS printer driver.

O Follow the procedure below when using a printer driver other than the RPCS:
¢ Set Collate and Rotating Collate in the printer driver.

e If you cannot make Shift Collate even with the optional finisher installed,
options may not be set up correctly in the printer driver. Correct the printer
driver's option settings.

* For details, see the printer driver Help.

Collate

Printed output is assembled as sets in sequential order.

>
123 123 123 123

AEU016S

Rotating Collate

Every other print set is rotated by 90 degrees.

-]

AEU0178
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ﬂlmportant

O The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.

O If the output tray has shift function, Shift Collate will be applied even if Ro-
tating Collate is selected.

< When Rotate Collate is cancelled

If the following functions are selected, Collate or Shift Collate will be applied
even if Rotating Collate is selected:

When combined with staple function.

When combined with punch function.

If jobs containing pages of various sizes are set.
When output tray is specified.

When combined with covers function.

When combined with slip sheet function.
When combined with chaptering function.

If custom size paper is set.

& Note

O When Rotating Collate has been selected, printing speed will be slower than
with other collate functions.

Shift Collate

The optional finisher is required for this function.

The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

1- ¢

AEU018S



Covers

Covers

Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.

*@*Important
O To use this function, Collate must be set. Rotating Collate cannot be set.

O The cover sheets should be the same size and orientation as the body of the
paper.

% Cover sheet
Prints the first page of the document on the sheet for the cover page.

* Print on one side
Prints on one side of the cover sheet only, even when duplex printing is se-

AEV016S

* Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.

* Cover sheet printed on both sides

TP

1

AEV017S

¢ Cover sheet printed on one side

e

A
2 /l
1 1

AEV032S
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Other Print Operations

e Blank

* When printing one side

W-gl

2
1 1

AEV018S

* When printing both sides

Tgip

2

1

AEV033S

< Front and Back Cover Sheet
Prints the first and last page of the document as the cover and back cover pages.

¢ Print on one side

Prints on one side of the cover sheets only, even when duplex printing is
selected.

* Back cover page face inside

=@l

2
1 2 1

AEV034S

* Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.

* Cover sheet printed on both sides, back cover page face inside, and the
number of pages is odd

T -BF

2

AEV037S
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Covers

¢ Cover sheet printed on one side, back cover page face inside, and the
number of pages is even

Tl

1 2

AEV038S

¢ Cover sheet printed on one side, back cover page face inside, and the
number of pages is odd m

T

1 2

1

You can not print on the outside of back cover page.
¢ Blank
* When printing one side

=)

o >

AEV040S

* When printing both sides

=

U
N
AN

AEV041S
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& Note

O If “Auto Tray Select” is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper in the [J orientation. There-
fore, if the cover paper is set to the [7 orientation, the orientation of cover and
body will be different.

A Reference
For printing methods, see the printer driver Help.

124



Chaptering

Chaptering

The specified page is printed on the same side as the first page, like a book. Also,
you can insert chapter slip sheets before specified pages, and select whether or
not to print on the slip sheets.

No slip sheets

The specified page is always printed on the same side as the first page.

9.7

AJO025S

& Note
O This function is only valid with duplex printing.

O Up to 20 pages can be specified as the front pages of chapters using the printer
driver.

O This function can be used together with combine (layout) printing.

A Reference
For printing methods, see the printer driver Help.
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Inserting chapter slip sheets

Insert chapter slip sheets before the specified page.

® Print
Prints on the chapter slip sheets. When duplex printing is selected, both sides
of the slip sheets are printed on.

ik

AJO023S

1k 4

AJO024S

@ Note

O Up to 20 pages can be specified as the front pages of chapters using the printer
driver.

O The slip sheet should be the same size and orientation as the body of the paper.

O If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in the [,) orientation.
Therefore, when the cover paper has been set to the LY orientation, the orien-
tation of the output cover paper and body paper will be different.

O The same paper feed tray cannot be set for the body of the document and the
slip sheet.

A Reference
For printing methods, see the printer driver Help.



Slip Sheet

Slip Sheet

« Inserting a slip sheet between each page

s

< Inserting a slip sheet between OHP transparencies

e Print

1‘3 = 11H?E

U
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& Note
O Collate cannot be set when using slip sheets.

O When the duplex printing or cover printing is set, you cannot insert slip
sheets.

O The slip sheet should be the same size and orientation as the main paper.

O If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in [J orientation.
Therefore, when the cover paper has been set to [’ orientation, the orienta-
tion of the output cover paper and body paper will be different.

O The same paper feed tray cannot be set for the main paper and slip sheets.



S
4. Direct Printing from a Digital

Camera (PictBridge)

What is PictBridge?

You can connect a PictBridge-compatible digital camera to this machine using a
USB cable. This allows you to print photographs taken using the digital camera
directly by operating the digital camera.

———

AMTO014S

Before you can use this function, the machine requires the following options:
¢ USB host interface board
¢ Camera direct print card

& Note
O Check your digital camera is PictBridge-compatible.

O Up to 999 images can be sent from the digital camera to the machine during
one print transaction. If an attempt is made to send more images, an error
message is sent to the camera and printing fails.

O Since printing conditions are specified on the digital camera, specifiable pa-
rameters depend on the particular digital camera. For details, see your digital
camera's manual.

O This function is compatible with USB 1.1.
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Direct Printing from a Digital Camera (PictBridge)

PictBridge Printing

Follow the procedure below to start PictBridge printing on this machine.

ﬂlmportant
O Do not disconnect the USB cable while data is being sent. If you do, printing
will fail.

O The USB host interface board is supplied with a USB cable and a hook onto
which you can roll up and hang the cable.

ﬂ Attach the hook on the back of the machine near the USB connection slot.
Attach the hook where it will not interfere with machine operation and access.

ﬂ Check the machine and the digital camera are both switched on.

8 Connect a USB cable between the optional USB host interface board in-
stalled on the machine and the digital camera.

The Data In indicator on the machine blinks for several seconds and “Pct-
Brdg” is displayed on the machine. This indicates the machine recognizes the
digital camera as a PictBridge device.

U |

6 ][
|-

op

AMTO017S

B On your digital camera, select the images you want to print, and specify the
printing conditions.

ﬂ The machine receives settings from the digital camera and starts printing.



PictBridge Printing

& Note

O Since printing conditions are specified on the digital camera, specifiable
parameters depend on the particular digital camera. For details, see your
digital camera's manual.

O Some digital cameras require settings for manual PictBridge operation. For
details, see your digital camera's manual.
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Direct Printing from a Digital Camera (PictBridge)

What Can Be Done on This Machine

This machine can perform the following functions using its PictBridge feature.
The settings available for these functions are as follows:
¢ Single image printing

¢ Selected image printing

¢ All image printing

¢ Index printing

¢ Trimming

¢ Date and file name printing

* Paper size

¢ Image print size

¢ Multi-Image-Layout

¢ Printing quality

¢ Color matching

* Paper type specification

¢ Form printing

¢ Camera memo printing

& Note
O This machine does not support the following settings:

¢ DPOF printing
* Margin-less printing

O The setting parameters and their names may vary depending on the digital
camera. For details, see your digital camera's manual.

Index Printing
A3 (297 x 420)
Horizontal images x vertical images (in) Paper orientation
12x 16 E
16 x 12 -

& A4 (210 x 497)

Horizontal images x vertical images (in) Paper orientation
8x 12 E
12x8 =
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What Can Be Done on This Machine

< A5 (148 x 210)

Horizontal images x vertical images (in) Paper orientation
5x8 [
8x5 =

% Letter (8'/> x 11)

Horizontal images x vertical images (in) Paper orientation
8x 10 E
10x 8 =

< B4 (257 x 367)

Horizontal images x vertical images (in) Paper orientation
10 x 14 E
14 x 10 [y
& Note

O Index printouts vary depending on the orientation of the paper placed on the
specified size tray.

O Depending on the digital camera, a form feed may be inserted after one set of
images belonging to one type ends.

O The number of images in each size of paper is fixed.

Trimming

Use this function to print only the inside of the trimming area specified on the
digital camera.

AGZ007S

1 - Trimming area
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Direct Printing from a Digital Camera (PictBridge)

Date and File Name Printing

Use this function to print the date and/or file name under the image.

aaaaaa
bbbbbb

AGZ005S

In the above figure, “aaaaa” indicates the file name and “bbbbb” indicates the

date.
Paper Size
Use this function to print on paper with the size specified on the digital camera.
Paper size name Actual size
2L (5” x 7”) 178 mm x 127 mm (5 in. x 7 in.)
Postcard 148 mm x 100 mm
100 mm x 150 mm 150 mm x 100 mm
4” x 6” 152.4 mm x 101.6 mm (4 in. x 6 in.)
8” x10” 254 mm x 203.2 mm (8 in. x 10 in.)
Letter (8 /2”7 x 117) 279.4 mm x 216 mm (8 1/, x 11)
117 x 17”7 431.8 mm x 279.4 mm (11lin. x 17in.)
A3 420 mm x 297 mm
A4 297 mm x 210 mm
A5 210 mm x 148 mm
A6 148 mm x 105 mm
B4 364 mm x 257 mm
B5 257 mm x 182 mm
B6 182 mm x 128 mm

& Note
O Specify Undefined Size for the 2L (5” x 7”), 100 mm x 150 mm, 4” x 6”, 8" x
10”7, A6, B5, and B6 sizes.
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What Can Be Done on This Machine

Image Print Size

Use this function to print images with the size specified on the digital camera.

T e

-- indicates the image size specified on the camera.

AGZ008S

You can specify the following image print sizes:

< Fixed size

3.25” x2.5”

5”7 x2.5”

6” x 4”

7" x 5"

10” x 8”

254 mm x 178 mm
110 mm x 74 mm
89 mm x 55 mm
148 mm x 100 mm
8 cm x 6 cm

10cm x 7 cm

13 cm x 9 cm

15 cm x 10 cm

18 cm x 13 cm

21 cm x 15 cm

24 cm x 18 cm

& Note
O An error occurs if the specified size is larger than the actual paper size.
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Multi-lmage-Layout

Use this function to print multiple images on the specified paper.

A

Y

AGZ002S

The number of images that can be printed on one page are as follows:

Paper size Number of images that can be specified
2L (5" x77) 2,4,8,9
Postcard 2,4
100 mm x 150 mm 2,4
4" x 6” 2,4,8,9
8” x 10” 2,4,8,9,16,25,32

Letter (8'/2” x 117)

2,4,8,9,16,25,32

117 x 17”7 2,4,8,9,16,25,32,49, 64
A3 2,4,8,9,16,25,32,49, 64
A4 2,4,8,9,16,25,32

A5 2,4,8,9,16

A6 2,4,8

B4 2,4,8,9,16,25,32,49

B5 2,4,8,9,16,25

B6 2,4,8,9




What Can Be Done on This Machine

The number and arrangement of images that can be specified are as follows:

Number of images Vertical images x horizontal Paper orientation
images
2 2x1 E
4 2x2 [
8 4x2 E
9 3x3 =
16 4x4 =
25 5x5 =
32 8x4 [
36 6x6 =
49 7x7 =
64 8x8 g
& Note

O A form feed may be inserted between images depending on the digital cam-
era in use.

O Printing in the specified way may not be possible depending on the specifica-
tion for the number of images to be printed.

Printing Quality

Use this function to print images at the selected printing quality.

If you select [Default] or [Normal], the machine prints at 600 dpi x 600 dpi (2 bit);
if you select [Fine], the machine prints at 600 dpi x 600 dpi (4 bit).

Color Matching

Use this function to optimize colors when printing images.

If you select [Default] or [OFF], the machine prioritizes gradation for colour
matching, if you select [ON], the machine prioritizes saturation.
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Direct Printing from a Digital Camera (PictBridge)

Paper type specification

This function sends the machine's paper type information to the digital camera.
The names of paper types displayed on the digital camera's screen are different
to the names displayed on the machine. Use the table below to match the paper

types.
To display a paper type name on the digital camera's screen, use the machine's
display panel to set the paper type of the machine correctly.

The paper type detected by the digital camera The paper type of the machine
Default All type of paper
Plain Paper Plain or recycled paper

Form Printing

Use this function to print images in a predetermined layout format.

AGZ009S

Camera Memo Printing

Use this function to print text data together with an image if it is attached to the
image.
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Exiting PictBridge

Exiting PictBridge

Follow the procedure below to quit the PictBridge mode.

ﬂlmportant
O Do not disconnect the USB cable while data is being sent to the machine. If

you do, printing will fail.
ﬂ Check the display panel of this machine is displaying the “Ready” state.

ﬂ Disconnect the USB cable from the machine.
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Direct Printing from a Digital Camera (PictBridge)

Other Reference Information

For further details about printing on this machine, see the following:

/O Reference

Fore details about paper size, paper type, or tray settings, see General Settings
Guide.
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5. Saving and Printing Using

the Document Server

Accessing the Document Server

The Document Server enables you to store documents on the machine's hard
disk, allowing you to edit and print them as necessary.

ﬁlmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

& Note

O When you use the Document Server, the following functions can be selected
using the machine's control panel:

* Copies

e Collate

* Duplex

e Staple

* Paper selection: Paper source tray, paper type, paper output tray.
* Functions related to paper selection: Cover Sheet, Slip Sheet.

O The above items are dimmed, so you cannot set them from the printer prop-
erties dialog box when the Document Server is selected.

O You must enter a user ID, using up to eight alphanumeric characters.

Q

You should enter a Password and File Name to distinguish the job from others.

O Up to 1,000 files can be stored in the Document Server. No new files can be
stored after 1,000 is reached. Even if less than 1,000 files are stored, new files
cannot be stored when

* a file to be stored contains more than 1,000 pages,
¢ the total number of pages contained in files stored exceeds 2,000,
¢ the hard disk is full.

O The Document Server also stores files scanned using the Automatic Docu-
ment Feeder (ADF) or exposure glass. You should delete unnecessary stored
files once in a while so as not to exceed the capacity of the hard disk. For de-
tails about deleting stored files, see General Settings Guide.

O When using the hard disk for functions other than those of Document Server,
you may not be able to store new files in the Document Server, even if there
are less than 1,000 files stored.

/O Reference
For more information about Document Server functions, see General Settings
Guide.

For information about how to access Document Server from a client, see the
printer driver Help. 147
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6. The Functions and Settings
of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and explain all necessary functions and settings. This chapter describes the
functions and settings used for configuring the model you are using.

p Reference

For details about functions and setting items, see Network Guide, PostScript
3 Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:

Copy
Printer

Scanner
Fax
Document Server

& Note
O The machine must be equipped with the Printer /Scanner Unit in order to use

the printer or scanner function.
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Interface

The following interfaces are available with the machine:

Ethernet (100BASE-TX / 10BASE-T)
USB (2.0)

USB Host (1.1) (Optional)

IEEE 1284 (Parallel) (Optional)

IEEE 1394 (Optional)

IEEE 802.11b (Wireless LAN) (Optional)
Bluetooth (Optional)

& Note

O To use the IEEE 1284, IEEE 1394, IEEE 802.11b (wireless LAN), USB Host (Op-
tional) or Bluetooth interface, the machine must be equipped with the corre-

3 You cannot have the IEEE 1284, IEEE 802.11b (wireless LAN), and Bluetooth

O You cannot have the IEEE 1394 and USB Host interface on the machine at the

sponding unit for that interface.
interface on the machine at the same time.

same time.



List of the Setting Items

List of the Setting ltems

Web Image Monitor

The following tables show Web Image Monitor items that can be viewed or mod-
ified depending on the selected mode on the Web browser.

Select one of the following modes to log on Web Image Monitor:
¢ User mode: logged on as a user
¢ Administrator mode: logged on as an administrator

% Home
e Status
Menu User mode Administrator mode
Input Tray Read Read
Output Tray Read Read
Toner Read Read
¢ Configuration
Menu User mode Administrator mode
Function Read Read
System Read Read
Version Read Read
Printer Language Read Read
e Counter
Menu User mode Administrator mode
Copier Read Read
Printer Read Read
Fax Read Read
Send/TX Total Read Read
Fax Transmission Read Read
Scanner Send Read Read
Other Function(s) Read Read
¢ Inquiry
Menu User mode Administrator mode
Machine Maintenance/Repair | Read Read
Sales Representative Read Read
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< Document Server

e Document Server

User mode

Administrator mode

Read /Modify

Read/Modify

« Fax Received File

e Fax Received File

User mode Administrator mode
Read None
+ Printer: Print Jobs
e Print Job List
User mode Administrator mode
Read /Modify Read/Modify
% Job
e Job List
Menu User mode Administrator mode
Current/Waiting Jobs Read Read
Job History Read Read
e Printer
Menu User mode Administrator mode
Spool Printing Read Read
Job History Read Read
Error Log Read Read
¢ Fax History
Menu User mode Administrator mode
Transmission Read Read
Reception Read Read
LAN-Fax Read Read
¢ Document Server
Menu User mode Administrator mode
Print Job History Read Read
Fax Remote Send History | Read Read
Scanner Remote Send His- | Read Read

tory




List of the Setting Items

«» Address Book
e Address List

Menu User mode Administrator mode

Address Book None Read /Modify

% Configuration

* Device Settings

Menu User mode Administrator mode
System Read Read/Modify
Paper Read Read /Modify
Date/Time Read Read/Modify
Timer Read Read/Modify
Logs None Read/Modify
E-mail Read Read/Modify
Auto E-mail Notification None Read /Modify
On-demand E-mail Notification | None Read /Modify
File Transfer None Read /Modify
User Authentication Man- | None Read /Modify
agement
Administrator Authentica- | None Read/Modify
tion Management
Program/Change Adminis- | None Read/Modify
trator
LDAP Server None Read/Modify

* Printer

Menu User mode Administrator mode
Basic Settings Read Read /Modify
Tray Parameters (PCL) None Read /Modify
Tray Parameters (PS) None Read /Modify
PDF Temporary Password | Read None
PDF Group Password None Read /Modify
PDF Fixed Password None Read /Modify
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¢ Fax
Menu User mode Administrator mode
Environment Settings None Read /Modify
Send / Reception Settings | None Read /Modify
IP-Fax Settings None Read /Modify
IP-Fax Gateway Settings None Read /Modify
Parameter Settings None Read/Modify
* Interface
Menu User mode Administrator mode
Interface Settings Read Read/Modify
Wireless LAN Settings Read Read /Modify
* Network
Menu User mode Administrator mode
IPv4 Read Read/Modify
IPv6 Read Read /Modify
NetWare Read Read /Modify
AppleTalk Read Read /Modify
SMB Read Read /Modify
SNMP None Read /Modify
SNMPv3 None Read /Modify
SSDP None Read/Modify
Bonjour Read Read /Modify
System Log Read Available to read
* Security
Menu User mode Administrator mode
Network Security None Read /Modify
Access Control None Read /Modify
IPP Authentication None Read/Modify
SSL/TLS None Read /Modify
ssh None Read/Modify
Site Certificate None Read /Modify
Device Certificate None Read /Modify




List of the Setting Items

e RC Gate
Menu User mode Administrator mode
Setup RC Gate None Read /Modify
Update RC Gate Firmware | None Read /Modify
RC Gate Proxy Server None Read /Modify
* Webpage
Menu User mode Administrator mode
Webpage Read /Modify Read /Modify

¢ Extended Feature Settings

Menu User mode Administrator mode

Startup Setting None Read/Modify
Extended Feature Info Read Read

Install None Read /Modify
Uninstall None Read /Modify
Change Allocation None Read /Modify
Administrator Tools None Read/Modify
Copy Extended Features None Read /Modify
Copy Card Save Data None Read /Modify

& Note
O Some items are not displayed depending on the security settings.

telnet

The following telnet can be used with the machine:

access, appletalk, authfree, autonet, bonjour (rendezvous), btconfig, device-
name, dhcp, diprint, dns, domainname, help, hostname, ifconfig, info, ipp, ipv6,
lpr, netware, passwd, prnlog, route, set, show, slp, smb, snmp, sntp, spoolsw,
sprint, ssdp, ssh, status, syslog, upnp, web, wiconfig, wins
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Settings that can be used with PostScript 3

The following PostScript 3 settings can be used with the machine:

& Note

O Depending on a type of printer drivers, different items may be displayed.

Settings Selectable Items

Collate: Off, On

Dithering;: Auto, Photographic, Text, User Setting

Duplex: Off, Open to Left, Open to Top

Fit to Print Size: Prompt User, Nearest Size and Scale, Nearest Size and Crop

Image Smoothing:

Off, On, Auto, Less than 90 ppi, Less than 150 ppi, Less than
200 ppi, Less than 300 ppi

Input Tray: AutoSelect Tray, Bypass Tray, Tray 1, Tray 2, Tray 3, Tray 4

Output Tray: Printer Default, Internal Tray 1, Internal Tray 2, Internal Shift
Tray, Finisher SR3000 Upper Tray, Finisher SR3010 Shift Tray,
Finisher SR3000 Shift Tray, Finisher SR3000 Booklet Tray, Fin-
isher SR790 Upper Tray, Finisher SR790 Shift Tray

Resolution 600 dpi

Size: See General Setting Guide.

Staple: Off, Top Left, Top Right, 2 at Left, 2 at Right, 2 at Top, 2 at Center

Toner Saving

On, Off

Type:

See General Setting Guide.

Paper Selection

Same Paper for All Pages, Different Paper for First Page, Use
Slip Sheet, Chaptering

Punch:

Off, 2 at Left, 2 at Right, 2 at Top, 3 at Left, 3 at Right, 3 at Top,
4 at Left, 4 at Right, 4 at Top




Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications
Resolution 600 x 600 dpi
300 x 300 dpi
Printing speed ¢ Color:20ppm/25ppm/30ppm

e B&W:20ppm/25ppm/30ppm
(A4[), 8'/2 x 11 [J plain paper)

Printing speeds depend on the machine. Check which type of ma-
chine you have. See General Settings Guide.

Interface Standard:
¢ Ethernet interface (100BASE-TX / 10BASE-T)
e USB 2.0 interface
Option:
o IEEE 1284 parallel interface
Use a standard 36-pin printer cable not longer than 3 meters (10 feet).
e [EEE 1394 interface
e IEEE 802.11b wireless LAN interface
¢ Bluetooth interface
¢ USB Host interface

Network protocol IPv4, IPve6, IPX/SPX, AppleTalk
Printer language Standard: PCL 6/5¢c, RPCS

Option: PostScript 3, PDF Direct, PictBridge
Fonts PCL 6/5c:

Agfa Monotype 35 Intellifonts, 10 TrueType fonts, 13 International
fonts, and 1 Bitmap font.

PostScript 3 :
136 fonts (Type 2:24, Type 14:112)

Memory 1024 MB

Hard disk Storage capacity : 40 GB

Network cable 100BASE-TX / 10BASE-T shielded twisted-pair (STP, Category/Type5)
cable.
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Component Specifications

USB Interface (Standard) | ® Supported Operating System:
Windows Me / 2000 / XP, Windows Server 2003, MacOS 10.3.3
or later
¢ Transmission spec.
USB 2.0 Standard
¢ Connectable Device:
Devices corresponding to USB 2.0 Standard

& Note
O When using MacOS, use only the standard USB Interface. The optional USB
interface board is not supported.

O When using the USB Interface (Standard) with Mac OS 10.3.3, USB2.0 is sup-
ported.

O When using the USB Interface (Standard) with Windows Me, install USB
Printing Support. Windows Me only supports USB 1.1 speed.

Options

ﬂlmportant

O Only one optional interface board can be installed in the machine at a time.
Therefore, the optional IEEE 1394 interface board, the IEEE 802.11b interface
unit, the IEEE 1284 interface board, and Bluetooth interface unit cannot be in-
stalled concurrently.

IEEE 1394 Interface Board Type B

+ Transmission spec.:
IEEE 1394

< Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant

+ Device class:
SCSI print (Windows 2000 / XP, Windows Server 2003)
IP over 1394 (Windows Me / XP, Windows Server 2003)

+ Protocol:
SBP-2 (SCSI print)
TCP/IP (IP over 1394)

< Interface connector:
IEEE 1394 (6 pin x 2)



Specifications

% Required cable:
1394 interface cable (6 pin x 4 pin, 6 pin x 6 pin)

4 Note

O You cannot plug devices together to create loops.
O Do not use cable that is more than 4.5 meters in length.

+ Data transfer speed:
Maximum 400 Mbps

< Connectable number of devices on a bus:
Maximum 63

«» Allowed cable hops on a bus:
Maximum 16

 Power supply:
Non external power supply
Cable Power repeated (IEEE 1394a-2000 compliant)

IEEE 1284 Interface Board Type A

+ Transmission spec.:
IEEE 1284

% Required cable:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

+ Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

< Protocol:
TCP /1P, IPX/SPX, AppleTalk

& Note
O SmartDeviceMonitor and Web Image Monitor are supported.

+ Data transfer speed:

Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

 Frequency range:
¢ Inch version:
2412 - 2462 MHz (1 - 11 channels)
® Metric version:
2412 - 2472 MHz (1 - 13 channels)
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< Transmittable distance:
1 Mbps 400 m
2 Mbps 270 m
5.5 Mbps 200 m
11 Mbps 140 m

& Note
O These figures are a guideline for outdoor use. In general, the transmittable
distance indoors is 10 - 100 m, depending on environment.

% Transmission mode:
Ad hoc, and infrastructure mode

Bluetooth Interface Unit Type 3245

% Supported Profiles:
e SPP (Serial Port Profile)
¢ HCRP (Hardcopy Cable Replacement Profile)
¢ BIP (Basic Imaging Profile)

+ Frequency Range:
2.45 GHz ISM band

« Data Transmission Speed:
723 kbps

& Note

O The transmission speed is adjusted according to factors such as the dis-
tance and obstacles between the devices, radio signal condition and Blue-
tooth adaptor.

+« Maximum Range:
10 m

USB Host Interface Unit Type A

<+ Interface Connector:
USB 1.1 host interface A type

% Data Transmission Speed:
12 Mbps (Full speed)

< Distance Between Devices:
25 m
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Bluetooth Interface Unit Type 3245, 154 IEEE 1284 Interface Board Type A, 153
Bypass tray, 12 IEEE 1394 Interface Board Type B, 152
Custom size paper using the control panel, 15 IEEE 802.11b Interface Unit Type H, 153
setting the paper size using the control panel, 14 Initial Display, 2
Inserting chapter slip sheets, 126
C Installing the printer driver

Quick Install, 23
Installing the Printer Driver Using USB, 39
Interface, 151

Canceling a job
Windows, 108
Changing the order of jobs, 6

Chaptering, 125 J
Checking jobs in the print queue, 5
Collate, 119 Job List, 4
Control panel Job List screen, 4
hold print, 94
locked print, 91 L

printer features, 8

sample print, 88 List Per User ID
stored print, 97 printing all print jobs, 102, 104
Covers, 121 ' printing the desired print job, 102
, Locked print

Custom size paper

printing, bypass tray, 12 deleting, 94

printing, 92
D
M

Manuals for This Machine, i
Memory, 151

Deleting jobs, 7

Direct Printing from a Digital Camera, 129
Display panel, 2

Document Server, 141 N

E

Network cable, 151
Network protocol, 151
No slip sheets, 125

Error log, 110

F 0
Finisher, 114 .
Font Manager 2000, 57 OHP T1jan'sp arencies
Fonts, 151 printing, bypass tray, 16
Operating system, 151
H Options, 152

Hard disk, 151
Holding print jobs, 6
Hold print
deleting, 97
printing, 95
How to Read This Manual, 1
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PageMaker, 58 Thick Paper
PDF Direct Print, 75 printing, bypass tray, 16
PictBridge, 129 U

Camera Memo Printing, 138
Color Matching, 137
Date and File Name Printing, 134
Exiting PictBridge, 139
Form Printing, 138
Image Print Size, 135
Index Printing, 132
MultilmageLayout, 136
Other Reference Information, 140
Paper Size, 134
Paper type specification, 138
PictBridge Printing, 130
Printing Quality, 137
Trimming, 133
What Can Be Done on This Machine, 132
What is PictBridge?, 129

Printer Features Menu, 8

Printer language, 151

Printing a PDF file directly
PDF direct print, 75

Printing Method
PDF direct print, 75

Printing speed, 151

Printing with Bluetooth Connection
Windows, 51

Printing with Parallel Connection
Windows 2000, 44

Punch, 117

R

Resolution, 151
Rotating collate, 119

S

Sample print
deleting, 91
printing, 89

Shift collate, 120

Simplified Display, 3

Slip Sheet, 127

Specifications, 151

Spool printing, 112

Staple, 115

Stored print
deleting, 101
printing, 98

Unauthorized copy control, 80
data security for copying, 80
mask type, 82
USB Host Interface Unit Type A, 154
Using commands, 79
Using the Print Job Function, 84

w

Windows

canceling a job, 108
Windows 2000

printer properties, PCL, 60

printer properties, RPCS, 68
Windows 95/98/Me

printer properties, PCL, 59

printer properties, RPCS, 66
Windows NT 4.0

document defaults, PCL, 64

document defaults, RPCS, 72

printer properties, PCL, 64

printer properties, RPCS, 72
Windows Server 2003

printer properties, PCL, 62

printer properties, RPCS, 70
Windows XP

printer properties, PCL, 62

printer properties, RPCS, 70
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Network interface cables with ferrite core must be used for RF interference suppression.
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